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SECTION 1 Introduction to the Mapper

1.1 Overview of the Mapper

The Mapper is a visualisation and editing tool common to a number of CERC models,
which allows model features to be created, edited and displayed graphically. The
features you see in the Mapper vary depending on which model it is being used with;
for example, some are available across all models and some are specific to ADMS 6,
ADMS-Screen, ADMS-Urban, ADMS-Roads or ADMS-Airport.

The Mapper can be used to create, edit and display the following model features:

e Point, jet, line, area, volume and road sources,
e Buildings,
e Specified point receptors,
e Output grids.
Additionally,
e Grid sources and aircraft sources can be displayed,
e Specified points given in an *.asp file can be displayed,
e Terrain and roughness files can be visualised,
e A background map can be added to the Mapper to assist in locating features,

e Model output can be displayed in the Mapper as contour or vector plots by using
the 2D output plotter,

e A 3D visualisation of the features can be made,
e Data from raster layers in the Mapper can be extracted into a *.csv file,
e Mapper layers can be exported into various file formats,

e Input files for use directly in the ADMS models’ Advanced Street Canyon and
Urban Canopy Flow modules can be created using the Canyon and canopy tool,

e Multiple *.shp files can be combined into a single file using the merging tool.
Instructions on how to launch the Mapper are in Section 1.2.

Figure 1 shows the Mapper with the main features labelled. The menu options available
from the menu are described in Section 1.3, the key interactions available are discussed
in Section 1.4, right-click pop-up menus are described in Section 1.5 and the toolbar
buttons in Section 1.6. The remaining parts of the Mapper, the layer panel and the map
view window, are discussed in Sections 1.7 and 1.8 respectively. Instructions on how to
set the coordinate system in the Mapper are given in Section 1.9.

Following this introduction, Section 2 describes how to set up and save a Mapper
project file and edit features of the ADMS input using the Mapper; Section 3 explains
how to view model results in the Mapper; Section 4 describes how to modify the
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SECTION 1 — Introduction to the Mapper

appearance of a layer; Section 5 deals with additional items such as importing
background images, visualising input in 3D and exporting to Google Earth, together
with other advanced features; finally SECTION 6 details the tools included in the
Mapper for various applications such as extracting raster layer data and exporting layers
into a file, among others.

Menu bar Map view
@ Mapper / — [m] >
Project Edit View Layer Tools Settings Help
Toolbar ——3 5%+ g% eavaaaoe @as - -iah .
/. A
Layers tab : B [+ Foad sources 1@
: B ¥ Aeasouices )]
: B W Volume sources ]
: 0w Grid source cells [0)
Layer panel [ =P |o Gupuguteen
: B [w Output grid points (361)
| +
i .
. : uip 1 -
At‘trl butes \_:_ Paint sources
1| Name Can Fiespray
: Geomety Frint v
Il eoMsUben | vew | BT
Status bar Eap.DSGESE British Mational Grid (epsg:27700) ¥ 54427721 ¥: 259643.52 | Editing: none Scale: 1:8500
Figure 1 - The Mapper with the main features labelled.
1.2 Launching the Mapper
To launch the Mapper from the ADMS model interface, select the Mapper menu item or
. =]
click on the J button on the Setup screen.
1.3 Menu options

There are six main menus: Project, Edit, View, Layer, Tools and Settings. The Project menu
includes options to save, open and close a project; allows you to define whether the
coordinates are part of a known projected or geographic system, e.g. Ordnance Survey
OSGB coordinates, via the Set map coordinate system option — this is described further in
Section 1.9; and to exit the Mapper. The Edit menu allows you to edit features in the
Sources, Buildings and Specified points layers, which also applies any changes made to the
model, and allows copying of images to the clipboard. The View menu provides options
to change the map view. The Layers menu includes options to add, remove, export and
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SECTION 1 — Introduction to the Mapper

reorder the selected layer in the layer panel; to display the layer statistics; to clip the
layer to polygons from another layer; and to use the layer coordinate system in the map
view. The Tools menu launches utilities such as the Output Plotter, Extract data tool,
Canyon and canopy tool and Shape file merging tool. The Settings menu includes
options to edit preferences for viewing and gridding options; and to save the layer
settings or restore the factory settings. Additionally, there is a Help menu. The menu
options available are outlined in Table 1.
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SECTION 1 — Introduction to the Mapper

Menu Option Use
New Opens a new project.
Open... Open a previously saved project file.
Save Save the current project under the current file
name.
Save as... Save the current project with a user-specified file

Project name.

Use the ADMS coordinate system | Sets the coordinate system used in the Mapper to
the same as that defined in the ADMS interface.

Set map coordinate system This allows you to set the coordinate system to a
projected or a geographic system, or to turn off
the coordinate system.

Close Closes the Mapper.

Add feature Add a feature to the selected layer, e.g. a point, a
polygon etc.

Edit feature Edit the geometry of a feature in the selected
layer.

Shift feature Move a feature in the selected layer.

Delete feature Delete the selected feature.

Rotate a feature Rotate the selected feature.

Edit Undo Undo the current changes while editing.

Redo Redo the last Undo.

Save edits Saves the edits made to the model.

Copy map to clipboard Copies the current view in the map window to the
clipboard.

Copy legend to clipboard Copies the top part of the layer panel to the
clipboard.

Copy scalebar to clipboard Copies the scalebar to the clipboard.

Zoom to layers Set the map view to show all the data in all the
layers.

Zoom to layer Set the map view to the extent of the selected
layer.

Zoom in Zoomiin.

Zoom out Zoom out.

View Zoom Zoom to display an area defined by clicking with
the mouse on the map and dragging the cursor. A
single left-click of the mouse on the map will
make a fixed zoom in at the point clicked. A right-
click will make a fixed zoom out.

Previous extent Return to the previously displayed extent in the
map view.
Next extent Go to the next extent in the map view window.

Mapper User Guide
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SECTION 1 — Introduction to the Mapper

Menu Option Use
Pan Move the map view without altering the scale.
Refresh layers Obtain the latest data from the model for all the
layers and update the map view.
Refresh layer Obtain the latest data from the model for the
selected layer and update the map view.
Change view (2D/3D) Toggle the map view between 2D and 3D mode.
Add layer Allows a layer to be added, e.g. a background
map.
Remove layer Removes the selected layer from the map view.
Export layer... Allows the selected layer to be exported to file in
a choice of formats.
Move to top Moves the current layer to the top of the layer
panel.
Move to bottom Moves the current layer to the bottom of the layer
panel.
Layer Add WMS Allows you to add a URL for a WMS layer.
Add background map Adds the background map to the map view
window.
Feature information View information about a model feature in the
map view window.
Statistics Displays statistics about the current layer. See
Section 5.11
Clip to polygon Creates a new layer containing features from the
current layer clipped to polygons from another
layer. See Section 6.3
Use CS for map Sets the map coordinate system to that used by the
current layer
Measure Measure the distance between two or more points
in the map view window.
Contours Launch the Output Plotter for concentration plots.
See Section 3.1
Flow field Launch the Output Plotter for flow field plots. See
Section 3.2
Tools - -
Extract data from raster layers Converts raster data to comma delimited file
format. See Section 6.1
Canyon and Canopy Generates advanced street canyon and urban
canopy flow parameter files for use in ADMS.
See Section 6.4
Merge SHP files Combines multiple *.shp files and allows editing
of fields. See Section 6.5
Snap to shape Option to snap to nearby shapes when adding and
editing vertices.
Settings | pisplay scalebar Option to show/hide the scalebar.
Display north arrow Option to show/hide the north arrow.
Gridding option Allows selection of gridding method.

Mapper User Guide
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SECTION 1 — Introduction to the Mapper

Menu Option Use
Save all layer settings as default | Saves the current appearance of the layers (colour,
symbol etc.) as the default appearance.
Restore factory settings Restores the default appearance of the ADMS
layers.
Hel User guide Opens the Mapper User Guide.
e
P About Mapper Displays information about the Mapper, e.g.
version number and CERC contact details.

Table 1 - Menu options in the Mapper.

Mapper User Guide

Page 11




SECTION 1 — Introduction to the Mapper

1.4

Keyboard & mouse interactions

There are several keyboard interactions for functions in the Mapper, as listed in Table
2.

Action Function

Layer panel

Pressing the delete key while a user layer is selected in the layer panel

Delete will delete that layer.

Pan and zoom

Holding down the shift key temporarily changes the mouse interaction

Shift — Mouse click with the map to pan, allowing you to move the map view.

Mouse wheel Rolling the mouse wheel back and forth zooms the map view out and in

When in zoom mode, holding down the control key whilst using the
mouse to zoom by click-and-drag will interactively scale the map image
to indicate the amount of zoom (in or out) that will be applied when you
release the mouse.

Ctrl — Mouse click

Editing
Delete Deletes the currently selected shape
Escape Cancels/reverts current edits/changes
Enter Completes current edits and deselects the shape, but doesn't save edits to
Double click the ADMS interface
Information
AltGr Ensures that only features in the currently selected layer can be clicked

1.5

151

Table 2 - Key interactions in the Mapper.

Note that the pan and zoom functions can be used whilst editing a feature. This is
useful, for example, if you are drawing a source which covers a large distance such as
a road.

Pop-up menus

You will find context-sensitive pop-up menus when you use the mouse to right-click
in the Mapper. These give quick access to relevant actions while you are working with
the Mapper.

The layer context menu

When you select a layer in the layer panel and right-click with the mouse, the
following context menu will appear. The menu is context-sensitive and only the menu
options that apply will be enabled.
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SECTION 1 — Introduction to the Mapper

@Mapper
Project Edit View Layer Jools 3Settings Help

L9F T BE BRE IO

Layers Grauping

Settings

B Line

/ Use layer C5 for map
B [v Roac

Move to top

B v Area Move to bottom
E [ Yolu Simplify layer

‘_ Refresh contours
B v Grd

L Export layer »

P i

2 Dup Clip layer to polygons

E v Outp
+

Statistics

Deselect layer

Remove layer

T

The details of these actions can be found in the relevant sections of this document.

Menu option

Use

Layer settings

Opens the layer properties dialog. See Section 4 and Section 5

Import layer Changes the appearance of the layer. See Section 4.8
settings...

Export layer Saves the layer settings to file for re-use later. See Section 4.8
settings...

Reload default Resets the appearance of the layer. See Section 4.8

settings file

Settings | g,ve default

Saves the layer settings as the defaults so they will automatically be

settings file used the next time you open the Mapper. See Section 4.8
View active Opens the current layer settings file in a text editor
settings file

Share colour ramp

Shares the colour ramp of the current layer (if any) with every other
layer of that type in that group

Share renderer

Shares the renderer of the current layer (if any) with every other layer
of that type in that group

Use layer CS for map

Sets the map coordinate system to that used by the current layer

Move to top

Moves the current layer to the top of the panel (only available in the
Layers tab)

Move to bottom

Moves the current layer to the bottom of the panel (only available in
the Layers tab)

Simplify layer

Simplifies the geometry of features belonging to the current layer if
possible. See Section 2.3.3.

Refresh contours

Redraws contour lines to match up with their associated contour layer.
See Section 4.5.

Export layer

Quick access to common file export options such as ADMS SPT,
Google Earth and ESRI Shape. See Section 6.2

Clip layer to polygons

Creates a new layer containing features from the current layer clipped
to polygons from another layer. See Section 6.3

Statistics

Displays statistics about the current layer. See Section 5.11

Deselect layer

Deselects the currently selected layer in the layer panel

Remove layer

Removes the selected layer from the layer panel and map view. This is
only available for user layers. See Section 1.7.1.

Mapper User Guide
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SECTION 1 — Introduction to the Mapper

1.5.2 The add/edit context menu

When adding or editing features in the map view you can display a pop-up menu
specifically dealing with different edit options when you right-click on the map or an

edited feature.

B wmapper
Project Edit View Layer Jools Settings Help
Le¥r BT TR D e
Layers )

A
B % Grid source cells (0]

B ¥ Dutput grid extent

Bl ¥ Output grid paints [351]
+

Qav|la-kcabxo B wd-

The details of these actions can be found in the relevant sections of this document.

Menu option

Use

Delete feature

Delete the selected feature from the current layer.

Finish editing the currently selected feature without saving all edits. See

Finish edit Section 2.3.2

Cancel edit Cancel the edits to the currently selected and deselect it.

Undo Undo the edits to the currently selected feature without deselecting it.
Redo Redo the edits that have just been undone.

Save edits Save the edits made during the current editing session to the model.
Clear all edits Clear all edits made during the current editing session

Simplify Simplify the geometry of the current feature if possible. See Section

2.3.3.

Simplify to [n] vertices

Simplify the geometry of the current feature such that there will be n (or
fewer) vertices after the simplification. Option only available if the
current feature has more than the maximum number of vertices (n)
allowed by the ADMS model.

1.6 Toolbar buttons

The toolbar contains buttons that allow layers, features in the ADMS layers, and the
map view to be edited, as well as providing access to the 2D output plotter. The purpose
of each of the buttons is summarised in Table 3 and Table 4. The remaining sections
then illustrate how these are used to view, create and edit data.

When using a tool that requires the user to specify a location in the map view window,
the appearance of the cursor will change.

Mapper User Guide
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SECTION 1 — Introduction to the Mapper

Button Name Cursor Function
. Export layer N/A | Export the current layer to a file.
D Add background N/A Adds a background map to the map view window.
map
¥ Add layer N/A | Add a new layer from a file.
Remove the selected layer from the layer panel and map
% Remove layer N/A view. This is only available for user created layers.
Obtain the latest data from the model for all the layers and
% Refresh layers N/A | odate the map view,
Obtain the latest data from the model for the selected layer
L2 Refresh layer N/A and update the map view.
o] Zoom to layers N/A | Set the map view to show all the data in all the layers.
A} Zoom to layer N/A Set the map view to the extent of the selected layer.
& Zoom in N/A | Zoomin.
= Zoom out N/A | Zoom out.
Zoom to display an area defined by clicking with the mouse
Q Zoom Q on the map and dragging the cursor. A single left-click of the
mouse on the map will make a fixed zoom in at the point
clicked. A right-click will make a fixed zoom out.
(T Pan ITb Move the map view without altering the scale.
< Previous extent N/A Return to the previously displayed extent in the map view.
o Next extent N/A | Go to the next extent in the map view window.
@ Information & View information about a model feature in the map view
window.
= Extract data from N/A Convert raster data to comma delimited file format.
raster layers
Measure the distance between two or more points in the map
4 Measure e view window.
. Add a feature to the selected layer, e.g. a point, a polygon
/1 | Add feature O otc.
. Save the edits made during the current editing session to the
o Save edits NIA | el
| Edit feature @ Edit the geometry of a feature in the selected layer.
' Shift feature -+ Move a feature in the selected layer.
X Delete feature N/A | Delete the selected feature.
Rotate N/A otate the selected feature.
R he selected f
Y Undo N/A Undo the current changes while editing.
edo N/A edo the last Undo.
c Red / Redo the last Und
]ﬁ Contours N/A Launch the Output Plotter for concentration plots.
4 Flow field N/A | Launch the Output Plotter for flow field plots.
Change view Toggle the map view between 2D and 3D mode. The icon
W= N/A changes depending on the map mode. When viewing in 3D

mode additional buttons are available as shown in Table 4.

Table 3 - Mapper toolbar buttons
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SECTION 1 — Introduction to the Mapper

Button Name Cursor Function
Changes the camera pan mode so that the
Htl* Camera ‘_@ camera position is changed by yaw and pitch
- position rotations. Use the drop down arrow to change
the mode.
Changes the camera pan mode so that the
Camera XYZ @b camera position is changed by vertical

translations and left-to-right horizontal

translations.

Changes the camera pan mode so that the

@ camera position is changed by left-to-right and
forward-and-backward translations in the

horizontal plane.

Camera XY

Changes the camera pan mode so that the

{&> | Camerarotation | &= camera position is changed by point-of-view
rotation.
1:} Sun position Changes the light and shade of the display.

% Zoom Q Zoom in and out.

Table 4 - Mapper toolbar buttons for 3D display

The Add Feature button will change appearance depending on the layer currently
selected. For the Buildings, Area sources and Volume sources layers, the appearance of the
Add Feature button depends on the shape of the building/source to be added; this can be
changed using the drop down arrow to the right of the button. Some of the buttons are
only available under certain conditions; for instance, the Add Feature, Edit Feature and
Shift Feature buttons are only available if the current selected layer can be edited from
within the Mapper. If a button is not currently available it will be greyed out.

1.7 The layer panel

There are three tabs in the layer panel: Layers, Grouping and 3D. The first two tabs show
the ADMS data layers and a feature attributes table. The Layers tab lists the layers in the
order in which they appear in the map view. The Grouping tab groups the layers
according to their type, e.g. all source layers will be listed under the Sources group. The
3D tab shows the additional options for visualising in 3D. The 3D manipulation is
described in Section 5.9 and the Layers and Grouping tabs are described next.

1.7.1 Layers and Grouping tabs

The Layers and Grouping tabs show the ADMS data layers along with any user defined
layers, such as contour plots or background images. The layers that are present when the
parent interface and Mapper are first launched are referred to as ADMS layers. These
layers contain all the sources, buildings, and output locations for the *.apl or *.upl file
currently open in the model interface. Unlike user layers, you will not be able to delete
these layers directly from the Mapper layer panel. To update the display to reflect any
changes that have been made in the model interface, e.g. through opening a new *.apl or
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1.7.2

1.7.3

1.74

*.upl file, or adding a new source, click on the Refresh All Layers button % on the
toolbar.

For each of the ADMS layers that can contain multiple features, the layer panel shows
the name of the layer, the number of features in that layer (e.g. the number of point
sources) and the symbol used to represent that layer. Details of how you can change the
symbology and other layer options are given in Section 4. The Output grid extent layer
only shows the name of the layer and the symbol used to represent the layer.

The number displayed in the layer panel provides a handy count of the number of
sources of each type that have been entered into the interface.

flow field plots generated using the Flow field button 1.2, or web map services (WMS),
background images and data layers added using the Add Layer button¥ (or drag-dropped
onto the layer panel). Any user defined layers can be removed by first selecting the
layer and then clicking on the Remove Layer button% ; alternatively they can be removed
by selecting the layer in the layer panel, right-clicking on the layer and selecting Remove
layer from the pop-up menu, or simply hitting the delete key on the keyboard. Details
about creating contour layers can be found in Section 3 and instructions for adding a
background map as a layer can be found in Section 5.2.

Attributes table

An Attributes table is displayed beneath the layer panel. The Attributes table is populated
when you select the Information tool and click on a feature; refer to Section 5.6 for full
details. The splitting and the sizes of the attributes table and layer panel can be adjusted
by dragging the horizontal divider. Similarly, the vertical divider between the layer
panel and the map view window can be adjusted.

Showing and hiding layers

If a layer is visible then the data contained in that layer are shown in the map view
window. A layer can be hidden by unchecking the checkbox next to the layer name.
To make the layer visible again recheck the checkbox.

Reordering layers

The ordering of the layers in the Layers tab determines the order in which they are
shown in the map view window. Features from layers at the top of the Layers tab are
shown on top of features from layers further down and thus may hide them from view.
There are three different ways to reorder the layers within the Layers tab:

1. Click on the layer you wish to move, holding down the mouse button. Once a
red bar appears, move the layer to its new position, and then release the mouse
button.

2. Use the Move to top and Move to bottom right-click options on a particular layer.
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3. Click on the layer you wish to move. Press and hold the Ctrl button and then

press the 1 or | arrow keys to move the layer up or down.

The symbol used to represent a layer can be made partially transparent to allow
features in layers below them to be seen. See Section 4.1 for more details on making
layers transparent. Note that layers cannot be reordered from the Grouping tab.

1.8 The map view window

The map view window is where the data from the current visible layers are shown. Both
the ADMS and user-defined layers are shown in this window. The scale of the map
view window is given as a scalebar in the bottom right corner of the map view window
and as a numerical scale on the right hand side of the status bar. The position of the
cursor in the map view window is given in the status bar, as well as the value at that
position if a raster layer containing data values is selected.

The scale and extent of the map view window is controlled by various toolbar buttons:

To zoom and centre the window on the features of all the (unhidden) layers click
on the Zoom To Layers button on the toolbar. ]

To zoom and centre the window on the features of the currently selected layer
click on the Zoom To Layer button on the toolbar. &

To zoom in to a central point in the map view window click on the Zoom In
button on the toolbar. &

To zoom out from a central point on the map view window click on the Zoom Out
button on the toolbar. =

To view a selected region in the map view window click on the Zoom button on
the toolbar. &

Click in the top left corner of the region you want to view, and while holding
down the mouse button drag the cursor to the bottom right corner of the region
you want to view, then release the mouse button to set the extent of the map
view window.

To move the view in the map view window without altering the scale click on
the Pan button on the toolbar. (3

Then click and drag the mouse in the map view window to move the view.

To return to a previous viewing extent in the map view window click on the
Previous Extent button on the toolbar. <

To go to the next viewing extent in the map view window click on the Next
Extent button on the toolbar %. This option is only available after the Previous
Extent button has been used.
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1.9 Coordinate systems

There is an option to set the coordinate system within the Mapper. The choice of the
coordinate system affects the way the ADMS layers are shown in the Mapper map view
window. Note that the coordinate system must be selected before certain features of the
Mapper can be used; for example, before exporting Mapper files to *.kml files for use in
Google Earth.

Coordinate systems can also be defined separately for each layer. This is necessary to
ensure that additional features, such as background maps, use the correct coordinate
system for the data they are displaying. Typically you would set the map coordinate
system to match that used by the parent interface. However, if you have a lot of data in a
user layer with a different coordinate system, you might choose that for the map to
avoid CPU-intensive re-projection of the data as you move about in the map view. The
coordinate system for the ADMS layers should not be changed in the Mapper — this is
set for all ADMS layers in the model interface; see the relevant model User Guide for
more details.

Full details of how to set the coordinate system are given in Section 5.1.
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This section outlines how to use the Mapper to view, create and modify the geometry of the
model data. The model data that can be manipulated with the Mapper varies depending on
which model it is being used with, but include sources, buildings, specified output points,
output grids and terrain and roughness files.

2.1 Mapper projects

Mapper projects are a convenient way to manage files and data you wish to view in the
Mapper that are associated with a given task. Any data added to the Mapper project, such as a
background map or contour plot, will remain in the project after saving. The project will also
remember any custom settings for the ADMS layers that you may have configured. The file
name extension of a Mapper project file is *.mpj.

To save the current Mapper project, select the Save project command from the Project menu, or,
to save the current project under a new name, select Save project as... from the Project menu.
Once the project has been saved, the filename will appear in the form title at the top of the
Mapper. When using the Mapper with a compatible model, for example ADMS, the project
will also be entered into the Mapper project file panel on the Setup screen of the ADMS
interface. In this way you can associate *.apl or *.upl files with a project so that all your
added data is loaded automatically when you start the Mapper.

Note that the project file has a required associated file with the file extension *.ttkgproject. If
the Mapper project is moved to a different directory after it has been created, the associated
* ttkgproject file must be moved with it.

You can choose to open a Mapper project at any time, regardless of any *.apl or *.upl file you
may have loaded in the parent interface. This will display all the user layers referenced by the
project, and also apply the project configuration to the ADMS layers. It also reassigns the
Mapper project file in the parent (e.g. ADMS) interface.

To close the Mapper project, select the New command from the Project menu, the current
project will then close, clearing all the user layers and project configuration settings, and
leaving only the ADMS data displayed in the Mapper using the default layer configurations.

To view existing data from an *.apl or *.upl file refer to Section 2.2; or to add, modify the
geometry of, move, or delete a feature refer to the instructions in Sections 2.3 to 2.10.

2.2 Viewing existing data

To view existing sources, buildings, specified output points, the output grid and output
points, first open the *.apl or *.upl file in the model interface. Then return to the
Mapper and click on the Refresh Layers button % on the toolbar. Some layers will only
appear in the Mapper once they have been selected for modelling in the parent interface.
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This can include buildings, specified output points, the output grid, complex terrain and
surface roughness options. For details of how to set these options see the model user

guide.

2.3 General source editing

This section covers how to add, move or delete sources using the Mapper. To follow
these instructions, make sure you already have the *.apl or *.upl file which is to be
edited open in the model interface, i.e. the file to which you wish to add, move or delete
sources. Also make sure that the Mapper is open.

2.3.1 Adding a source

Step 1

Step 2

Step 3

Step 4

Step 5

Select the appropriate layer in the layer panel e.g. the Point sources layer,
the Area sources layer etc.

Click on the Add Feature button on the toolbar to select it. Note that the Add
feature button changes appearance depending upon which type of source is
being edited. For example the Add feature button for point sources uses a
dot symbol, * . For area and volume sources, click on the drop down arrow
and select either Polygon or Circle.

Click in the map view window at the location where you want the source
to be placed. If you are adding a line source in ADMS 6 you will need to
click at the location of either end of the line; remember a line source must
have precisely two vertices in ADMS 6. If you are adding a polygonal area
or volume source, or a road or line source in ADMS-Urban, ADMS-Roads
or ADMS-Airport, you will need to click in the map view window at each
vertex location, and double click when placing the last vertex to finish
defining the source. If you don’t double click at the end of the drawing,
you can still complete the edit by pressing enter on the keyboard or right-
clicking with the mouse and choosing Finish edit from the pop-up menu. If
you are adding a circular area or volume source, you will need to click in
the map window on the location of the centre of the source, and while
holding down the mouse button, move the cursor until the circle is of the
required diameter before releasing the mouse button. This will create a
polygon representation of the circle.

When drawing road sources, for example, enable the Snap to shape option
from the Settings menu in order to easily connect road ends of adjoining
sources, or disable it for fine edits.

You will need to click on the Save edits button on the toolbar, 4, to
complete all editing in the layer and commit the new features
(alternatively, right click the mouse to bring up a pop-up menu and select
the Save edits option).

A new source of the appropriate type is created and displayed in the Source
screen of the model interface. The source coordinates have been filled in
automatically but you will need to fill in the other parameters for the
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source. Refer to the model user guide for further details.

2.3.2 Editing a source

Follow these steps to edit an existing source from within the Mapper.

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Select the appropriate layer in the layer panel e.g. the Area sources layer.
Click on the Edit Feature button on the toolbar to select it. £
Select the source you want to edit by clicking on it.

If you are editing a source with multiple vertices (e.g. area source) and
wish to add a new vertex, do as follows. Click on the starting vertex of the
edge you wish to split into two, e.g. click on vertex 3 if you wish to add a
new vertex between the current vertices 3 and 4. The selected vertex
should turn red, with the rest of the vertices coloured green. Alternatively,
use either the full stop (.) or comma (,) keys on the keyboard to select a
different vertex. Then click on the location of the new vertex.

For multiple vertex sources, the modified shape of the selected source will
appear as a dashed line during editing.

To move a vertex, click and drag that vertex to the new location before
releasing the mouse button.

To delete a vertex, click on the vertex you wish to delete in order to select
it, and then click on that vertex again.

If you want to edit other sources in the same layer without saving all edits,
you can complete the current edit by pressing enter on the keyboard or
right-clicking with the mouse and choosing Finish edit from the pop-up
menu. You can now select another source to edit as in Step 3.

Click on the Save edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.
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Figure 2 - Pop-up menu showing editing options.

2.3.3 Simplifying source geometry

When you are editing a source with multiple vertices (e.g. a road source) you can use
the Simplify option from the right-click pop-up menu in Figure 2 to reduce the number
of vertices. This will remove as many vertices as possible while preserving the
approximate shape of the original source. Simplify uses the Douglas-Peucker vertex
removal algorithm with a tolerance of 1 m to systematically remove vertices and
simplify the polyline or polygon.

If the source being edited has more than the maximum number of vertices allowed by
the ADMS model, another option, Simplify to [n] vertices, will become available from
the right-click pop-up menu. This will force the simplification to result in n (or fewer)
vertices, increasing the default tolerance of the algorithm if necessary.

There is also an option to simplify the geometry of all sources of a particular type
simultaneously. To do this, right-click on the appropriate layer in the layer panel, e.g.
the Road sources layer, and click Simplify layer. This generates a Simplify report that
displays the results of the layer simplification before they have been applied; an
example is shown in Figure 3. You should then choose whether to apply the layer
simplification by clicking either Save changes or Discard changes as appropriate. There
is also a Copy report button that allows you to copy the report text to the clipboard.

Running Simplify layer will ensure that no sources in the layer have more than the
maximum number of vertices allowed by the ADMS model.
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Figure 3 - Example Simplify report

2.3.4 Moving a source

Follow these steps to change the location of an existing source from within the

Mapper.

Step 1
Step 2
Step 3

Step 4

Select the appropriate layer in the layer panel e.g. the Point sources layer.
Click on the Shift Feature button on the toolbar to select it. £3

Click on the appropriate source, and while holding down the mouse button
move the cursor to the new location for the source before releasing the
mouse button.

Click on the Save edits button on the toolbar to save the changes to the
model.44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.3.5 Rotating a source

Line, road, area and volume sources can all be rotated in the horizontal plane within
the Mapper. To do this, follow these steps:

Step 1

Step 2
Step 3

Step 4

Select the appropriate layer in the layer panel e.g. the Area sources layer.

Click on the Rotate button on the toolbar to select it. %

Click on the appropriate source, away from its centre, and while holding
down the mouse button, move the cursor around the centre of the source
until you are happy with its new location (indicated by a red outline),
before releasing the mouse button.

Click on the Save edits button on the toolbar to save the changes to the
model.44. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option
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2.3.6 Deleting a source

2.4

2.5

Follow these steps to delete an existing source from within the Mapper.

Step 1 Select the appropriate layer in the layer panel e.g. the Point Source layer.
step2 Click on the Edit Feature button on the toolbar to select it. £

Step 3 Select the source you want to delete by clicking on it in the map view
window.

Step4 Click on the Delete Feature button on the toolbar. 3. Or press the belete
key on your keyboard.

step 5 Click on the Save edits button on the toolbar to save the changes to the
model. 4d. Alternatively, right click the mouse to bring up a pop-up menu
and select the Save edits option.

Step 6 Repeat this process to delete further sources.

Grid sources and aircraft sources

Grid sources and aircraft sources can be displayed in the Mapper, but they cannot be
added, edited or deleted.

To view a grid or aircraft source add the source in the model interface following the
instructions in the ADMS-Urban or ADMS-Airport User Guide. In the Mapper click on
the Refresh Layers button®8. The sources will now be displayed.

Specified output points

In this section we look at how to add, move or delete specified output points using the
Mapper. To follow these instructions, make sure you already have open in the model
interface the *.apl or *.upl file to which specified points are to be added, edited or
deleted. Also make sure that the Mapper is open. Also ensure that Specified points is
selected as an output location type in the Grids screen of the model interface.

2.5.1 Adding an output point

Step 1  Select the Specified Points layer from the layer panel.
Step 2 Click on the Add Feature button on the toolbar to select it. *

step 3 Click on the location in the map view window where you wish to place the
specified output point.

Step 4 Click on the Save edits button on the toolbar to save the changes to the
model. 44. Alternatively, right click the mouse to bring up a pop-up menu
and select the Save edits option.
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Step 5

Step 6

A new specified output point has been created and is displayed in the Grids
screen of the model interface. The X and Y co-ordinates have been
automatically entered but the rest of the parameters need to be filled in.
See the model user guide for more details.

Repeat this process to add further specified output points.

2.5.2 Moving an output point

Step 1
Step 2
Step 3

Step 4

Step 5

Select the Specified Points layer from the layer panel.
Click on the Shift Feature button on the toolbar to select it. £

Click on the specified output point you wish to move, and while holding
down the mouse button, move the cursor to the new location for the
specified output point before releasing the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4d. Alternatively, right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process for all the specified output points you wish to move.

2.5.3 Deleting an output point

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Specified points layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. <1

Select the specified output point to delete by clicking on it in the map view
window. The selected specified output point will have a red dot on it.

Click on the Delete Feature button on the toolbar, 3, or press the Delete
button on your keyboard.

Click on the Save Edits button on the toolbar to save the changes to the
model. 44. Alternatively, right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to delete further specified output points.

2.6 Specified output points file

If you wish to add a large number of specified points you can do this quickly by
including an *.asp file in the ADMS model interface to define their locations. Refer to
your model user guide for instructions on how to do this. The locations of the specified
points defined in the *.asp file can be viewed in the Mapper by following these steps.

Step 1 Add the file path for the *.asp file to the model interface, refer to the model
user guide for instructions on how to do this.

Step 2 In the Mapper click on the Refresh Layers button$8. The specified points in the
*.asp file will now be displayed.
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The specified points in the *.asp file cannot be edited or deleted using the Mapper; this
can be done only by editing the *.asp file directly.

For very large *.asp files, only the first 500,000 points will be displayed.*

2.7 Output grid

In this section we look at how to define a new output grid using the Mapper. To follow
these instructions, make sure you already have open in the model interface the *.apl or
*.upl file with the output grid you wish to redefine, and ensure that the Mapper is also

open.

Regular and variable grids can be displayed in the Mapper, but only regular grids can
be defined using the Mapper. Variable grids must be defined in the ADMS interface.
Therefore, if you wish to define the output grid with the tool in the Mapper, ensure
that Gridded output points is selected as an output location type and the gridded output
spacing set to Regular in the Grids screen of the model interface.

You can only redefine or move an output grid; you cannot edit or delete an existing

output grid.

2.7.1 Defining an output grid

Step 1

Step 2
Step 3
Step 4

Step 5

In the ADMS interface, ensure that Gridded output points is selected as an
output location type and the gridded output spacing set to Regular in the
Grids screen.

Select the Output grid extent layer in the layer panel.
Click on the Add Feature button on the toolbar to select it. [d

Click on the location of one corner of the output grid in the map view
window, and while holding down the mouse button, move the cursor to
draw the output grid required before releasing the mouse button.

A new output grid has been defined and is displayed in Grids screen of the
model interface. The new extent of the grid will have been filled in
automatically but if any other parameters need to be changed these must be
altered from the interface. Refer to the model user guide for more details.

Note that the grid point locations are shown in the Output grid points layer but
they cannot be edited in the Mapper. The number of points in the grid is
displayed in brackets.

Any type of grid point can be displayed in the Mapper.

! The maximum number of data points shown in any layer can be edited manually in the Mapper settings file.
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2.7.2 Editing the output grid

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Output grid extent layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. £

Click anywhere within the current output grid extent. Three of the grid
vertices will appear as green dots and the fourth vertex as a red dot.

The vertex with the red dot indicates which corner of the output grid will
be movable. To select a different vertex, use either the full stop (.) or
comma (, ) keys on the keyboard.

Click in the map window, and while holding down the mouse button,
move the cursor until the red grid vertex is in the desired location before
releasing the mouse button.

Click on the Save edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.7.3 Moving the output grid

Step 1  Select the Output grid extent layer from the layer panel.

Step 2  Click on the Shift Feature button on the toolbar to select it. o

step 3 Click anywhere within the current output grid extent, and while holding
down the mouse button, move the cursor to the new location for the output
grid before releasing the mouse button.

Step 4 Click on the Save edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.8 Buildings

This section outlines how to add, move, edit or delete buildings using the Mapper. To
follow these instructions, make sure you already have open in the model interface the
*.apl or *.upl file to which buildings are to be added, edited or deleted. Make sure that
the Mapper is also open. Also make sure that the Buildings option is selected in the Setup
screen of the model interface.

Rectangular buildings must consist of 4 vertices and be rectangular in shape. If the
shape entered is not rectangular but is convex and has 4 vertices then the Mapper will
convert the shape to be rectangular.

The main building will be shown with a red outline. See the relevant model User Guide
for more details about setting the main building.

2.8.1 Adding arectangular building

Step 1

Select the Buildings layer from the layer panel.
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Step 2

Step 3

Step 4
Step 5

Step 6

Use the drop down arrow on the Add Feature button on the toolbar to select
Polygon and then click on this button to select it. <3

Click in the map view window on the locations of the four vertices of the
building in order, either clockwise or anticlockwise. Double click when
placing the last vertex to finish defining that building. Alternatively, press
enter on the keyboard, or right-click with the mouse and choose Finish edit
from the pop-up menu, after placing the last vertex.

Repeat this process to add further rectangular buildings.

Click on the Save Edits button on the toolbar to finish editing and save the
changes to the model. 4. Alternatively right click the mouse to bring up a
pop-up menu and select the Save edits option

The new buildings will have been created and are displayed in the Buildings
screen in the model interface. Enter the rest of the parameters for these
buildings and then exit the Buildings screen. See the model user guide for
more details.

2.8.2 Adding a circular building

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Select the Buildings layer from the layer panel.

Use the drop down arrow on the Add Feature button on the toolbar to select
Circle then click on the button to select it. <

Click in the map view window on the location of the centre of the
building, and while holding down the mouse button, move the cursor until
the circle is of the appropriate diameter, and then release the mouse button.

Repeat this process to add further circular buildings.

Click on the Save Edits button on the toolbar to finish editing and save the
changes to the model. 44. Alternatively right click the mouse to bring up a
pop-up menu and select the Save edits option.

The new buildings will have been created and are displayed in the Buildings
screen in the model interface. Enter the rest of the parameters for these
buildings and then exit the Buildings screen. See the model user guide for
more details.

2.8.3 Editing arectangular building

Step 1
Step 2
Step 3

Step 4

Select the Buildings layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. <1

Select the rectangular building whose geometry you wish to alter in the
map view window. The vertices of the selected building will appear as red
or green dots.

For each vertex you want to move, click on that vertex, and while holding
down the mouse button, move the cursor to the new location of that vertex
before releasing the mouse button.
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Step 5

Step 6

Click on the Save Edits button on the toolbar to finish editing this building
and save the changes to the model. #d. Alternatively right click the mouse
to bring up a pop-up menu and select the Save edits option.

Repeat this process to edit the geometry of further rectangular buildings.

2.8.4 Editing a circular building

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Buildings layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. £

Select the circular building whose geometry you wish to alter in the map
view window. The outline of the selected building will appear as a series
of green or red dots.

Click in the map window, and while holding down the mouse button,
move the cursor until the circle is of the required diameter before releasing
the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to edit the geometry of further circular buildings.

2.8.5 Moving a building

Follow these instructions to use the Mapper to change the location of an existing
building, either rectangular or circular, without altering its shape.

Step 1
Step 2
Step 3

Step 4

Step 5

Select the Buildings layer in the layer panel.
Click on the Shift Feature button on the toolbar to select it. £

Click on the building you wish to move, and while holding down the
mouse button, move the cursor to the new location of this building before
releasing the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to move other buildings.

2.8.6 Rotating a building

Buildings can also be rotated in the horizontal plane within the Mapper. To do this,
follow these steps:

Step 1

Step 2
Step 3

Select the Buildings layer in the layer panel.

Click on the Rotate a feature button on the toolbar to select it. %
Click on the appropriate building, away from its centre, and while holding

Mapper User Guide

Page 30



SECTION 2 — Using the Mapper

Step 4

down the mouse button, move the cursor around the centre of the building
until you are happy with its new location (indicated by a red outline),
before releasing the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

2.8.7 Deleting a building

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Buildings layer in the layer panel.
Click on the Edit Feature button on the toolbar to select it. <

Select the building you wish to delete by clicking on it in the map view
window. The vertices of the selected building will appear as red or green
dots.

Click on the Delete Feature button on the toolbar, 3. Or press the Delete
button on your keyboard.

Click on the Save Edits button on the toolbar to save the changes to the
model. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

Repeat this process to delete further buildings.

2.9 Coastline

This section outlines how to edit the coastline properties using the Mapper. To follow
these instructions, make sure you already have open in the model interface the *.apl or
*.upl file to which the coastline properties are to be edited. Make sure that the Mapper is
also open. Also make sure that the Coastline option is selected in the Setup screen of the
model interface.

2.9.1 Coastline

The coastline is represented by a line between the two coastline vertices. The Coastline
layer can be manipulated in the following ways:

e The Add feature button ¢ can be used to redraw the coastline. Press the mouse

button down at the location of the first vertex, hold the mouse button down and
drag the cursor to the location of the second and then release the mouse button.

The Edit feature button A can be used to move one of the vertices of the
coastline. First click on the coastline then click and drag the vertex to move it
to its new location. Then click the Save edits button 4.

The Shift feature button L can be used to move the whole coastline. Click and
drag on the coastline to move it to the new location and then click the Save edits
button .
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e The Rotate a feature button 2 can be used to rotate the coastline about its
centrepoint. Click and drag on the coastline to put it in the new orientation and
then click the Save edits button .

2.9.2 Coastline point on land

The coastline point on land is represented by a single point. This point can be moved
in the Mapper by first selecting the Coastline land layer in the layer panel, then selecting

the Add feature button * and clicking in the new location. This point must be at least
0.1 m away from the line representing the coastline.

2.10 Terrain and roughness files

Any complex terrain or variable surface roughness that has been included in the model
can be visualised in the Mapper. To view this data in the Mapper, first make sure that
the complex terrain option has been selected in the model interface and that either the
terrain file path (*.ter) or the roughness file path (*.ruf) has been selected and
specified. Refer to the model user guide for further details on modelling and including
complex terrain and variable roughness.

After the complex terrain file(s) have been included click on the Refresh Layers button
% in the Mapper. A representation of the variable terrain or surface roughness, or
both, will then be displayed in the map view window. Initially, the variable terrain or
roughness layer is shown with a default colour scale and default number of height or
roughness levels. These can be edited; see Section 4.6.

It is possible to view a 3D visualisation of the terrain and other input. Further details
on this are given in Section 5.9.

Extremely large terrain and roughness files can be displayed in the Mapper, but only
the first 500,000 points will be displayed. This limit can be changed in the Mapper
settings file, or alternatively the terrain file can be converted to a grid instead; see
Section 5.6 for more details.
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the Mapper

Contour and vector plots of model output results can be created and viewed in the Mapper.
The 2D output plotter can produce contour plots using the in-built interpolator, or using
Golden Software’s Surfer, if the user has this program installed. Section 3.1 describes how to
plot model output. Section 3.2 describes how to plot flow field output. For details on changing
the appearance of a contour layer once it has been produced refer to Section 4.5.

3.1 Contour plotting

Step 3

Step 4

Step 5

Step 6

Use the Settings > Gridding option menu to select the Interpolator or the Surfer
option as desired and then click on the Contours button. @

The 2-D Output Plotter screen will appear. The Interpolator mode is shown in
Figure 4.

lé 2-D Output Plotter (Plotting in Mapper with Interpolator) s
Output type
* Contour E
" Elow field

" Temperature and humidity

Path: d:\Examples Dataset to plot

|24

[_J Example10
[_J Exampled

Examplal.gst Time [year. day, hour]
Example2.gst
Example3.gst

™ Show specified points files

Advanced Options... | Grid zettings : 200 » 200 grid lines - Matural Meighbour

Short-term files [FGST.%PST) Iin: Max:

Figure 4 - The 2-D Output Plotter (Contour) with Interpolator screen.

Select the file type (short or long term), the file containing the results, the
Dataset and the Time (if required) to be plotted.

If required, use the Advanced Options... button to change the number of grid
lines or to specify user defined contour levels, as shown in Figure 5. The
Gridding method can also be changed. The options available with the
Interpolator option are Inverse Distance, Kriging, Kriging (all points), Natural
Neighbour and Triangulation (additional options are available with Surfer). The
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appearance of the output contours will depend on which of these has been
chosen. Natural Neighbour is a suitable choice in most instances. Once
advanced options have been selected, click Close to return to the main output
plotter screen.

Step 7
Step 8

Step 9

Advanced Options

Gridding options
¥ Specify number of grid lines

4 ® 200
™ ¥ only, auto-calculate
Y 200
Y only, autg-calculate ¥
Contour levels
| [Autamatic) j o
i
r _Browse |

A grid with 4 columng and ' rows will be used

Contour gridding methad
|Natural Neighbour j

Wector gridding method
|Natural Meighbour

Current reference paint

=l
|

Temrain gridding method
|Natural Meighbour J

0K Cancel

Miry [LETS

Figure 5 - The Advanced Options screen for the ADMS Contour Plotter with

Click on the Plot button.

You are asked to enter a name for the grid file. After entering a file name
click on the Save button.

Interpolator.

Figure 6 shows an example of a contour plot in the Mapper.

The contour layer will appear in the Mapper map view window, along with a
layer for the contour lines.

8 Mapper

Project Edit View Layer Tools Settings Help

PFTBTLIRTBYIQID @

Layers Grouping kein)

"
3 [« Road sources (0]

O ¥ Area sources (0]
A

B v YVolume sources (0]

B [v Grid source calks (0]
L

& [v Output grid extent

B[ Output grid points (361]
+

B[ Methane ppb conlours
/

Map: OSGE36 British Mational Grid (spsg: 27700)

@as| -~

EE wd-

% 27237268 Y- 196830.28 | Editing: none

500 m

Scale: 1:23,800

Figure 6 - Example contour plot.
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3.2 Flow field plotting

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Use the Settings > Gridding option menu to choose either the Interpolator or Surfer

option. Click on the Flow field button.l2 The rest of this example assumes that
the in-built interpolator has been selected.

The 2D Output Plotter screen will appear, as shown in Figure 4.

& 2-D Output Plotter (Plotting in Mapper with Interpolator) X
Output tppe File type
" Cortour # Hesults for sach met. conditiore E
{* Flow field " Results averaged over all met. conditions
(™ Temperature and humidity Cloge
Path: D:\Eramplzs Type of graph Height [rn)
S =l | & wind st
0
= = U
[ Example1l ok’
(C Examples
oW

i Ux longitudinal
{7 Uy transverse Format of Graph

" wind speed * Contours
" Wectaors [wind platz only]

r

" Tubulence [mds):

o
o

I
- i
-
Advanced Options. .. | Gnd settings : 200 = 200 gnd lines - Matural Meighbour
Chooze this option to plot output for each met. condition Mir: Max:

Figure 7 - The 2-D Output Plotter (Flow field) with Interpolator screen.

Select the file type (Results for each met. condition or Results averaged over all
met. conditions), the file containing the results, the type of graph (Wind or
Turbulence), the height for which the flow field is to be plotted and the format
of the graph (Contours or Vectors). If contours are being plotted then you must
select which component of the flow field or turbulence that you wish to plot.

If required, use the Advanced Options... button to change the number of grid
lines or to specify user defined contour levels, as shown in Figure 5. The
Gridding method can also be changed. The options available with the
Interpolator option are Inverse Distance, Kriging, Kriging (all points), Natural
Neighbour and Triangulation (additional options are available with Surfer). The
appearance of the output contours will depend on which of these has been
chosen. Natural Neighbour is a suitable choice in most instances. Once
advanced options have been selected, click OK to return to the main output
plotter screen.

Click on the Plot button.

You are asked to enter a name for an intermediate file. After entering a file
name click on the Save button.

The plot will appear in the Mapper map view window.
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Figure 8 shows an example of a flow field vector plot in the Mapper.

B Mapper
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Figure 8 - Example vector flow field plot.
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3.3 Displaying footprints

After performing an ADMS model run in which the Output per source option was
selected, it is possible to visualise the data in the extra output files created by this option
(.sst/.slt files) in the Mapper. These files contain the short-term/long-term contribution
of each source to the concentration and/or deposition at each specified receptor point.
The data to be viewed in the Mapper is controlled via a form that is launched from the
model interface; refer to the model user guide for full details.

An example visualisation in the Mapper is shown in Figure 9. Each included source is
filled with a colour that indicates to what degree it contributes to the concentration at
the selected receptor, as indicated by the blue square. The default colour scales can be
modified if desired; refer to Section 4.

E ¥ Paint footprint (2]

© 0.om7
© 00033
@ 0.0050
@ 0.0067
B ¥ Line tootprint (0]

B ¥ Road footprint (2]
il

Va

Pl

/18

Za
B ¥ Aircraft footprint (0]
B ¥ Area footprint (0]
B ¥ Yolume footprint (0]
B ¥ Grid footprint (0]

B ¥ Paint sources (2]
L]

Map: 0SGE3E British Mational Grid (eprg:27700)

@Mapper _
Project  Edit View Layer Tools Settings Help

PTFTIVMTL MR D @as|- - & wd-

Layers Grouping 30

X 54464546 ' 259436.54 | Editing: none

150 m

Scale: 16,440

Figure 9 - Example footprint plot.
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3.4 Viewing numerical results

After an ADMS model run numerical results are written to *.gst, *.glt, *.pst, or *.plt
files (see the relevant model user guide for further details). The data in these files can be

displayed as a new layer in the Mapper. The example below is for a *.gst file, but the
method is similar for the other file types.

Any data file that is in comma-separated format can be displayed as a layer in the
Mapper provided it has some spatial information to place the data on the map. See
Section 5.5 for more details about this feature.

step1  Click on the Add Layer tool¥. A new window will appear as shown in

I Add Layer *
&« v » ThisPC » Local Disk (D:) » Example v 0 Search Example 2

Organise v Mew folder f=: ~ [T 0

~
Mame Date modified Type Size
3 Quick access
Mo it tch y h

@ OneDrive - Personal

[ This PC

¥ Network

File name: v| Common files ks

Figure 10 - Add Layer window.

Step 2 Change the file type from Common files to All Files (*.*).

Step 3 Navigate to the *.gst file you wish to view and click Open. A new window
will appear as shown in Figure 11.

As an alternative to Steps 1-3, the file can be drag-dropped from Explorer onto
the layer panel.
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@ Select data to use in layer: Examplel.gst O X

File: D:ME=ampleshExamplel. gst Lines: 2584

Start line: | Endline: |2884 ¥ End cf file Delimiter: |. Reload

Year Day Haur Tirnelz] ) ) Zlrn) Conclug/mi3| ~
# ''ear Ciay Haour Time(s] #[m) *'[m) Z[m] Conclugsm3]:
1 ‘rear Diay Haour Time(s) #[m) *'[m) Z(m) Conclugs/m3]:
2 1 939 939 939 .00 -200.00 .00 0.500000E +C
3 1 939 939 939 10E.E7 -200.00 .00 0.500000E +L
4 1 939 939 939 213.33 -200.00 .00 0.508476E+[
5 1 939 939 939 32000 -200.00 .00 0.BE0774E+[
[ 1 -939 -939 -939 42667 -200.00 .00 0.935730E +L
7 1 939 939 939 533.33 -200.00 .00 0.114726E+(
8 1 939 939 939 £40.00 -200.00 .00 0.125684E+(
9 1 939 939 939 74E.E7 -200.00 .00 0.129313E+0
10 1 939 939 939 853.33 -200.00 .00 0.128721E+(
1 1 939 939 939 960.00 -200.00 .00 0.125973E+(
12 1 939 939 939 1066.67 -200.00 .00 0.122240E+[
13 1 939 939 939 1173.33 -200.00 .00 0.118186E+(
14 1 939 939 939 1280.00 -200.00 .00 0.114130E+L
15 1 939 939 939 1386.67 -200.00 .00 0.110239E+L
16 1 939 939 939 1493.33 -200.00 .00 0.106537E+L
17 1 -939 -939 -939 1600.00 -200.00 .00 0.103239E+L
18 1 939 939 939 1706.67 -200.00 .00 0.1007148E+0
19 1 939 939 939 181333 -200.00 .00 0.973414E+(
20 1 939 939 939 15920.00 -200.00 .00 0.947794E+[ v
A 3
0 Gotoline | Coreert data to arid using: Matural Meighbour oK Cancel

Figure 11 - Data from *.gst file

Step 4  This window can be used to select which data you wish to display in the
Mapper. By default all of the data is selected. To change the selection first
scroll to the desired start line of data and right click on the index (the number
in blue) for that line. When the menu appears select Set as first data line. An
example is shown in Figure 12 for which the data for hour 2 is being selected
for display in the Mapper.

B Select data to use in layer: Examplel.gst m} X
File: D:\ExampleshExample.gst Lines: 2884
Start line:  |963 End line: |1923 [~ End of file Delimiter: |. Reload
Year Day Haur Timels] ) ') Z[m] Conclug/m3| A
957 1 993 5439 999 2BRE.E7 3200.00 .00 0.500000E +L
958 1 999 -939 999 277333 3200.00 0o 0. 500000E +(
959 1 993 939 939 2880.00 3200.00 .00 0.500000E +L
960 1 993 939 939 298667 3200.00 .00 0.500000E +L
961 1 993 5439 999 3093.33 3200.00 .00 0.500000E +L
962 1 999 -939 999 3200.00 3200.00 0o 0. 500000E +(
[963 - 2 aay -3535 00 -200.00 0 0.500000E +L
964 Set as first data line 399 10E.67 -200.00 .00 0.500000E +L
965 - 999 213.33 -200.00 .00 0.500000E +L
966 et aslast data line 233 32000 |20000 |00 0.500001E -+
967 Copy to header -339 426.67 -200.00 .00 0. 500256E+(
968 59 =394 939 533.33 -200.00 .00 0.504933E +L
969 2 -993 939 933 £40.00 -200.00 .00 0.525080E +{
970 2 -999 -939 -993 T4E.E7 -200.00 .0a 0.5EETEZE +(
971 2 993 939 939 853.33 -200.00 .00 0.6241 46E +L
972 2 993 5939 999 960.00 -200.00 .00 0.534340E +L
973 2 -993 939 933 1066.67 -200.00 .00 0.739265E +{
974 2 -999 -939 -993 117333 -200.00 .0a 0.785373E +(
975 2 993 939 939 1280.00 -200.00 .00 0.821461E+L
976 2 993 5939 999 138667 -200.00 .00 0.847965E +L
977 2 -993 939 933 149333 -200.00 .00 0.8661 35E +{ v
4 »
0 Go to line [~ Convert data to grid uzsing: Matural Neighbour Ok Cancel

Figure 12 - Setting the first data line

Step 5  Similarly, to set the last data line scroll to the desired line, right click on the
index, and click in Set as last data line. The selected lines will be highlighted in
green.
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Step 6

Step 7

The information at the top of the window shows you how much data is in the
file and which lines of data have been selected.

At this point you have the option to grid the selected data or add it as a set of
discrete points. To grid the data select the tick box beside the Convert data to
grid option; see Section 5.5 for more details about displaying data. Once you
have selected the data that you wish to display click OK. If you have not
gridded the data, it will then be displayed in the Mapper using the default red
square symbol as shown in Figure 13.

B Mapper - O e
Project Edit View Layer Tools Settings Help

TLOFTXIVE R340 @ag|.~ ELwd-

Layers Grouping 3D

CHVRSELEENEI N | 2 = & = 5§ 5 & & 5 5SS S EEEEEE SN NN
-------------------------------

B[ Pontsouces() | 00 smEssEsEsEsEsSsESSESSSSSEESESSESEEEEEEE@SN

®e | AsmsEsEsEESESEESESESESESESESEEESEESEESE@ESESEEN
B[ Lnesowces@ | s s sEsEE =SS SS =S85 SS S8 "8 S8 S8 5888888
...............................
B[ Roadsources(8 | = s EEEEEEEEEEEEEEEEEEEEEEEEEEEEEE
...............................
B[ Areasowces(l) | s e mEEEEEEEEEEEEEEEEEEEEEEEEEEEE
...............................
B[ Yolmesowces() | ' e EEEEEEEEEEEEEEEEEEEEEEEEEEEEE
...............................

= ,;'id sucseeledl ] g s sEEsEEE @SR EEEEEEEEEEEEEEEEEE

ol aesEE s NS E RS E RS EEEEEEEEEEEEEEEN
B Quputgidesent | gy g g EsEEssEEsSsEEESEEEEEEEEEEEE®
ool asssssEssEEssEESEEEEEEEEEEEEEEEN
B[ Ouputgidpon=(361) | i s sssssEEssEEsEssEEEEEEEEEEEEE
+ 1 sessssEssEsEsEsEEEsEEEEEEEEEEEEEES
-------------------------------
-------------------------------
-------------------------------
-------------------------------

Map: OSGE3E British National Grid (epsg: 27700] :1299.83 ¥ 2604.06 | Editing: none Scale: 1:26,000

Figure 13 - Data from the *.gst file displayed in the Mapper.

Information about the data can then be viewed. Ensure that the data layer is
selected in the layer panel. Select the information tool @ and click on one of
the data points. Full details on the information tool can be found in Section
5.6. Information is then displayed at the bottom of the layer panel in the
Attributes table. The information includes the name of the point, its elevation
and location, the hour or time for which the data comes from, the pollutant
concentrations at that point, and the spatial extent of the whole data in the
data file.

It is possible to colour the points according to their concentration, for
example, as shown in Figure 14. By importing a configuration file you can
quickly apply the same colour settings to multiple layers. See Sections 4.6 and
4.8 for further details.
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@Mapper
Project Edit View Layer Tools Settings Help

L/9F% LI RRAQG0 e+ @ad c-AMBRSOC | EEwS-

Layers Grouping in)

B[ Point sources [1]
L]

B[ Line souces (0)

B[ Road sources (8]

B[ Ares souses (1)

B[ Wolume sources (0]
A

B[ Grid source cells [0]
L

B[ Output grid extent

B Output grid points [981]
+

ADMSUrban | View |

400m

tap: OSGE3E British National Grid (epsg: 27700)

H 4075 107763 |Ed\tmg. none

[Seale: 116,700 |

Figure 14 - Numerical data displayed in the Mapper coloured by concentration.
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SECTION 4 Modifying the appearance
of layers

This section outlines how to modify the appearance of layers. The types of modification that
can be made depend on the type of layer you wish to modify. Sections 4.1 to 4.7 give details
of various different types of modification that can be made and the types of layer to which
these modifications can be applied. After modifying the appearance of the ADMS layers the
new appearance can be saved as the default appearance for ADMS layers by selecting Save all
layer settings from the Settings menu. The default appearance for ADMS layers can be restored
at any time by selecting Restore factory settings from the Settings menu. Note that this will save
the current appearance of all of the ADMS layers. The settings for individual layers can be
saved or reloaded by right-clicking on the layer and selecting Settings > Save default settings file
or Settings > Reload default settings file respectively. There is also the option to View active
settings file; selecting this option brings up a text file containing the current codes for the
selected layer. The settings for an individual layer can also be exported and then imported to
other layers, or imported in new maps later. This can be achieved by right-clicking on the
layer and selecting Settings > Import layer settings... or Settings > Export layer settings... as
appropriate. These options are discussed in Section 4.8.
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4.1 Modifying the transparency of a layer

The transparency of any layer can be changed. The transparency determines how “see-
through” the layer is and thus whether any features in a lower layer can be seen through
features in this layer. To change the transparency of a layer, follow these steps:

Step 1 Double click on the layer in the layer panel or select Settings > Layer settings
from the Layer context menu to bring up the layer properties window.

Step 2  Select General from the left panel and scroll to the Painting section, as shown

in Figure 15.
Vector: Point sources (1) *
+ = X w a Visible
General Parameters ~
Sections Path
B Section 1 r
Renderer |
Marker Name
Line
|P0int SOUrCes
Area
Label Caption
Chart |Point sources (1)
3D

Coordinate System

|OSGB 36 British Mational Grid (epsqg:27700) Select

Painting

| Basemap Transparency
[w Cached Paint 100 hd
|v¥ Ignore shape parameters
[~ Multipass rendering (slower!)
Scope (must be logical)
| =l
[v Prefer styling from config file
= @ v

Wizard ...

Figure 15 - The General section of the layer properties screen.

Cancel | Apply |

Step 3 Alter the Transparency value as required. 0 is completely transparent and 100
is completely opaque.

Step 4  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.2 Modifying the appearance of a marker layer

Markers are used to represent any layer of data defined as single points. For instance,
the ADMS layers for point sources are marker layers. To modify the appearance of one
of these layers follow these steps:

Step 1

properties window, e.g. the Point sources layer.

Step 2

Step 3

Select Marker from the left panel, as shown in Figure 16.

Double click on the layer of interest in the layer panel to bring up the layer

Vector: Point sources (1)
+ = X w a Visible
General Marker
Sections
& Section 1 Style Color Pattern
Renderer | . j | FFO000 j | j
]
Line ) .
Area Size Smart size
Label |160 twips j |El deg J |D|:|t j
Chart
3D Cutline
Style Color Pattern
| < oo <] [ ]
Width
2 twips -
¥ Indude in legend
L ]
&= @
Wizard ... OK | Cancel ‘ Apply ‘

Figure 16 - The Marker section of the layer properties screen.

used to represent the features in this layer.

Step 4

The Marker and Outline sections can be used to alter the look of the markers

Click on the OK button to make the changes and return to the Mapper

window, or click on the Apply button to make the changes but remain in the

and return to the Mapper window.

layer properties window, or click on the Cancel button to discard the changes
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4.3 Modifying the appearance of aline layer

Coloured lines are used to represent any layer of data defined as lines such as line
sources. To modify the appearance of this layer follow these steps:

Step 1

Step 2

Step 3

Step 4

Double click on the layer of interest in the layer panel to bring up the layer

properties window, e.g. the Line sources layer.
Select Line from the left panel, as shown in Figure 17.

Vector: Line sources (1)
+ — X v a Visible
General Line
Sections
o Section 1 Style Color Pattern
Renderer ‘ j ‘ 000000 j | j
Marker .
”
Area o
Label |width =1m  ~] [opt ~| [odeg |
Chart
3D Smart size
B Section 2 opt -
Qutline
Style Color Pattern
| | oo <] [ som -]
Width
1 twips -
v Indude inlegend
= B
Wizard ... oK | Cancel ‘

Apply ‘

Figure 17 - The Line section of the layer properties screen.

The Line and Outline sections can be used to alter the appearance of the lines

used to represent the features in this layer.

Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes

and return to the Mapper window.
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4.4 Modifying the appearance of an area layer

Coloured areas are used to represent any layer of data represented by two-dimensional
regions in the Mapper, such as area or volume sources. To modify the appearance of
one of these layers follow these steps:

Step 1

properties window, e.g. the Area sources layer.

Step 2

Step 3

Double click on the layer of interest in the layer panel to bring up the layer

Select Area from the left panel, as shown in Figure 18.

Vecton Area sources (1)

+ = X v a

General

Sections

B Section 1
Renderer
Marker
Line

Label

Chart

3D

= B

Wizard ...

K
Visible
Area
Pattern Calor
e
|6 pt | |snt 7| |odeg =]
Smart size
Opt hd
CQutline
Style Color Pattern
| ] (oo ] [ soe ]
Width
|2twips j |Elpt J |Elc|eg J
¥ Indude in legend
Ok | Cancel | Apply |

Figure 18 - The Area section of the layer properties screen.

used in this layer.

Step 4

The Area and Outline sections can be used to alter the appearance of the shapes

Click on the OK button to make the changes and return to the Mapper

window, or click on the Apply button to make the changes but remain in the

and return to the Mapper window.

layer properties window, or click on the Cancel button to discard the changes
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4.5 Modifying the appearance of a contour layer

The colour scheme and number of contour levels used for a contour plot can be changed
either manually, by altering each of the individual levels, or by applying a new colour
scheme.

The contour levels can be manually altered by double clicking on the appropriate
contour layer in the layer panel to open up the layer properties window and then
selecting Grid from the left panel, as shown in Figure 19.

Raster: 502 ug/m3 *
+ - X ¥ a Grid
General
) Grid band
Sections
g Visible default »| [ Shadow [+ Antialiasing
Grid
n Minimum value Mayimium value
|5 |19.9375114440918
Height threshold
Minimum value Maximium value
5 19,9375114440918
Ramp

Min Max Legend
|5 |5.74 |s
+ 5] 5.74 5 ~
5.74 6.5
= 6.5 7.25
7.25 7.99 7.25
" 7.99 8.75
8.75 9.5

asg 1n 24 as
[ Smoaoth colors
-
= [E] [v Indude in legend

Wizard ... 0K ‘ Cancel ‘

Figure 19 - The Grid section for the layer properties screen for a contour layer.

To select a contour level, click on it. The following options are then available:

e Add a new contour level with the same properties as the current selected
contour level just above the current contour level by clicking on the Plus button

_* Inext to the contour levels.

e Delete the current selected contour level by clicking on the Minus button next

—_1to the contour levels.

e Delete all of the contour levels by clicking on the Cross button E next to the
contour levels.

e Alter the Min, Max or Legend values of the contour level by editing the contents
of the text boxes.
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e Alter the colour of a particular contour level by selecting it and then clicking
on the coloured rectangle to the left of the Min text box 1. This brings up the
Color screen, as shown in Figure 20. The colour can be changed by either
clicking on the colour wheel, using the sliders or editing the contents of the text
boxes. There are also some pre-set colours which can be viewed by clicking the
‘>” button. The lower slider (or Alpha text box) alters the colour transparency,
which can be useful for ‘seeing through’ certain regions of the contour plot.
Click OK or Cancel to return to the layer properties screen.

Celor *
Preview - |5tandard colors j
Current -
Hex FFFEFO000
Type . .
|ReB -] HHENR
e [ HEEEEE
Value Red ’F ...... .
| EEEEEEN u
Alpha Green ° EEEEEEEN |
_mumpmmm| e o EEEEEEEENEE
oK

Figure 20 - The Color screen

When the appropriate changes have been made, click on the OK button to make the
changes and go back to the Mapper window, click the Apply button to make the
changes but remain in the layer properties window, or click on the Cancel button to
discard the changes and return to the Mapper window.

A facility exists to automatically create a new graduated colour scheme for a contour
layer. To alter the colour scheme in this way, follow these instructions.

Step 1  Double click on the contour layer you wish to alter in the layer panel to bring
up the layer properties window.

Step 2 Click on the Wizard... button to start the Grid Ramp Wizard.

Step 3  Choose Simple classification to define a colour ramp with equally spaced
intervals or Advanced classification to get more interval spacing options, then
click Next >>. Choosing Simple classification brings up the window shown in
Figure 21.
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Step 4

Step 5

Step 6

Grid Ramp Wizard

™ Unigue values i+ Continuous values
Minimum value

|5

Maximum value
|19.9400005340578

v Use middle value

|12.4700002670288

MNext =>

<< Previous | Cancel |

Figure 21 - The Grid Ramp Wizard screen for setting the range of values.

This screen allows a choice between colouring by Unique values or by
Continuous values. For the contour layer, it is appropriate to choose Continuous
values so there is a smooth gradation in colours from low to high values. From
here set the Minimal and Maximal values.

If required, set a middle value. If this is not required then uncheck the Use
middle value check box, then click Next >>. Setting the values brings up the
window shown in Figure 22.

Grid Rarnp Wizard

* Color

Start color Middle color End color

|M rFrocoorr v | | Frorrooo v | | FRFRo0D0 v
[ Add new ramp to existing ramp Iv¥ Use HSL

" Ramps
| Autumn J
r r
r =3

i MNext == |

<< Previous | Cancel |

Figure 22 - The Grid Ramp Wizard screen for creating a new contour colour scheme.

Choose Color to select your own Start color, Middle color and End color, or Ramps
to choose from a pre-defined set of colour ramps, then click Next >>. Choosing
Color brings up the window shown in Figure 23.

Grid Ramp Wizard

Level every
|0, 143400005340576

Legend every
|1.49400005340576

<< Previous | oK

Figure 23 - The Grid Ramp Wizard screen for defining the intervals.
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Step 7 Set the spacing required between colour levels, Level Every, and the spacing
between legend entries, Legend Every.

step 8  Click on the OK button.
Step9  Uncheck the Shadow checkbox in the Grid section.
Step 10  If required, manually edit the contour levels.

Step 11  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.

Step 12  To update the contour lines so that they match the new contour levels, right-
click on the contour lines layer associated with the modified contour layer in
the layer panel, and click Refresh contours.
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4.6 Colouring alayer according to its properties

You may wish to colour a layer according to its properties. For example, you may wish
to colour a terrain file according to elevation; or a spatially varying roughness file
according to the roughness value; or you may wish to colour sources according to their
emission rates. This section describes how to make these changes.

Step 1 Double click on the layer which you wish to modify, for example the terrain
layer, to bring up the properties window, see Figure 24.

Vecton Terrain file (1024) e
+ = X W a Visible
General Parameters s
Sections Path
B Section 1 r
Renderer |
Marker Name
Line
|Terrain file
Area
Label Caption
Chart |Terrain file (1024)
3D
Coordinate System
|UNKNGWN (2psg:0) Select
Painting
[ Basemap Transparency
[v Cached Paint 0 :lv

[v Ignore shape parameters
[” Multipass rendering (slower!)

Scope (must be logical)

[ Prefer styling from config file
= & v
Wizard ... Cancel | Apply |

Figure 24 - The layer properties screen for a terrain file

Step 2  Click on the Wizard... button to start the Rendering Wizard.

Step3  Choose whether to use a Simple or Advanced classification, then click Next >>.
Choosing Simple classification brings up the window shown in Figure 25.

Rendering Wizard

Formula (select field andjfor add SQL like formula)

|Elevah'0n

(" Limited scan inside visible extent

" Full scan of the layer (slower!)

{Next >> || Cancel

<< Previous |

Figure 25 - The Rendering Wizard dialogue box
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Step 4  Using the drop down menu select the property according to which you wish
to colour the layer. For example, for a terrain layer select Elevation. Click on
Next >>.

Step 5  The next screen allows a choice between colouring by Unique values or by
Continuous values. The choice depends on the property you are using to colour
the layer. For the terrain layer, for example, it is appropriate to choose
Continuous values so there is a smooth gradation in colours from low
elevations to high elevations. On the other hand, when plotting surface
roughness, for example, the changes in roughness may be discrete, and it is
likely that there will be only a small number of different roughness values
across the region, so colouring by Unique values is more appropriate. The
choice can be made by selecting the appropriate radio button, and in the
continuous case you can also specify the range of values to use when
colouring the layer, see Figure 26. Click on Next >>.

Rendering Wizard

" Unigue values f* Continuous values
Minimum value
~ 23432

Maximum value
|300

[ Use middle value

v 150

[~ Use logarithmic scale

<< Previous ‘ Cancel |

Figure 26 - Selecting unique or continuous values

Step 6  On the next screen make sure that Render by Color is selected and then click on
Next >>.

Rendering Wizard

Render by Features
(* Marker (" Size [ Width
" Line {+ Color
(" Area " Outline width

(" Outline color

[v Indude in legend

<< Previous ‘ Cancel ‘

Figure 27 - Render by Color

Step 7 The next step is to choose the colour scheme for the layer. The method for
doing this depends on whether the layer is being coloured by continuous or
unique values.

For continuous values select Renderer from the left panel, see Figure 28. You
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can then change the minimum and maximum values at which the start and
end colours will be applied, as well as the start and end colours themselves
using the drop-down menus.

Vector Terrain file (1024) >
+ - ¥ v a Visible
General Renderer -
Sections
o Section 1 Render Expression (must be numeric) Round
Renderer Elevation j |D
Marker
Line First
Area ors
Label Number of zones Minimum value Maximium value
Chart 5 [2.8%-032 [300
3D
Start color End color Default color
- =R |. 008000 j ||:| FFFFFF j
Start gize End size Default size
8ot x| oot | Jent =
Second
MNumber of zones
|D ||:| ||:|
|. FFO0DD J |. FFFFFF J |. FFFFFF J
& @ | I N i e
Wizard ... OK | Cancel | Apply ‘

Figure 28 - The Renderer section of the layer properties screen

For unique values, a separate colour can be selected for each individual level.
To do this, select the appropriate field, e.g. Marker, from each section listed in
the left panel in turn, as shown in Figure 29. Then choose the colour for that
level using the Color drop-down menu.
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Step 8

Vector: Terrain file (1024)

+ — X v a Visible
General Marker
Sections
3 Section 1 Style Color Pattern
| B | foveser | e ] -]
Line ) .
Area Size Smart size
Label |160 twips j |III dea J |D|:|t j
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D Outline
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| | o <] [ ]
Width
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|
= @
Wizard ... Ok | Cancel Apply

Figure 29 - The Marker section of the layer properties screen

Finally, click OK to apply your changes.

If you wish to colour point sources by their emission rates, for example, then the steps
above can be followed, but at the stage when you select the formula from the drop-down
window in the Rendering Wizard you should choose the pollutant emission rate with
which you want to colour the layer, e.g. [NOx (g/s)].

It is possible to define new formulas in the Rendering Wizard, e.g. if you wished to
colour area sources by their total NOx emission rate you could specify the formula:
[NOx (g/m2/s)]*GIS_AREA by typing in the formula box.
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4.7 Displaying feature names

Any of the default ADMS layers can display the names of the features within that layer.
To show these names follow these instructions.

Step 1 Double click on the layer of interest in the layer panel to bring up the layer
properties window.

Step 2  Select Label from the left panel, as shown in Figure 30.

Vector: Point sources (1) x
+ — X w oA Visible
General Value X
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B Section 1 j
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Marker [ [ r
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Area Font
Chart
] |-‘*l'ic'|| J |3|3't J |. 000000 J
r r =
- -
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B [ 3] = 3
| 2500 twips | | 2500 twips | |iex -]

Qutline

& B | I — 1 1| v

Wizard ... OK | Cancel | Apply

Figure 30 - The Label section of the layer properties screen

Step 3 In the Value section, use the drop-down menu to set the Field to Name.

Step4  The Font, Label, Outline and Position sections can then be used to alter the
properties of the labels.

Step 5  The labels can be removed by unchecking the Visible checkbox in the Value
section.

Step 6  Click on the OK button to make the changes and return to the Mapper
window, or click on the Apply button to make the changes but remain in the
layer properties window, or click on the Cancel button to discard the changes
and return to the Mapper window.
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4.8 Exporting, importing, saving and reloading layer
settings

Once the layers have been modified as desired the layer settings can be exported so that
they can be used in other layers or in other maps. Similarly, existing layer settings can
be imported. The layer settings can also be saved and reloaded. The steps are
highlighted in the examples below.

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Right click on the layer you wish to export. This brings up the menu shown in
Figure 31.

& Mapper - O X
Project Edit View Layer Tools Settings Help
LOTYTXIRVYE RGO ¢ @as| - EL wd-
Layers Grouping D A
~
B v Road sources (0]
B v Area sources [0)
3 [v Vaolume sources [0]
3 [v Grid source cells [0]
AL
3 [v Output grid extent
B [+ Output grid points [361]
+
B [v 502 ugdm3 contours
Settings » Layer settings
Use layer CS for map e
Move to top Export layer settings...
Move to bottom Save settings file
Sty View active settings file
Refresh contours Share colour ramp
Export layer N Share renderer
Clip layer to polygons
Statistics
Deselect layer 350m
Remove layer
Map: O5GE3E British Mational Grio yepsgs 1 #: 273262.56 Y 197566.46 | Editing: nane Secale: 1:13.800

Figure 31 - The menu for exporting/importing layer settings.

Click on Settings > Export layer settings... .

A window opens prompting you to save the configuration file for the layer.
Choose a location and save the file with extension *.ttkstyle.

Right click on the layer to which you wish to import the settings. From the
menu select Settings > Import layer settings... .

Navigate to the layer configuration file that you have just created and click on
Open.

The layers are now displayed using the same layer settings.

The settings for an individual layer can be saved by right-clicking on the layer and
selecting Settings > Save settings file. These settings are then stored in a file so if you wish
to return to the saved settings, after making modifications, you can right-click on the
layer and select Settings > Reload settings file. This undoes any changes you have made.
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This section describes some of the more advanced features available in the Mapper.

5.1 Setting the map coordinate system

There are two aspects to consider when setting coordinate systems within the Mapper:
the map and the individual layers. The map coordinate system determines the way the
layers are displayed in the map view window, and you can choose one that suits your
needs provided it is compatible with the data. It can be either a projected or geographic
system. On the other hand, the layers each have a coordinate system, but these must
correspond to the data values in the layer. For example, the ADMS layers’ coordinate
system is set in the parent interface and acts on all the ADMS layers. This should be set
to whatever coordinate system you are using for your work in the model. For user layers
you often find the data have associated projection or world files that will define the
coordinate system for the layer automatically. This allows layers with data in different
coordinate systems to be projected correctly onto the map coordinate system for easy
comparison.

The map coordinate system is used as the default coordinate system for user layers with
no associated world file or other georeferencing information.

The coordinates of a point in the map view window (as given in the status bar) are in the
units associated with the map coordinate system. For example, if the map coordinate
system has been set to WGS 84 then the coordinates are degrees longitude and latitude.

The map coordinate system must be selected before certain features of the Mapper can
be used; for example, before exporting Mapper layers to *.kml files for use in Google
Earth.

The coordinate systems for the ADMS layers should not be changed in the Mapper —
these are set in the parent interface. See the relevant model User Guide for more
details.

To set the coordinate system that is used in the Mapper select either Use the ADMS
coordinate system or Set map coordinate system from the Project menu, as shown in Figure
32. The first option ensures that the system currently defined in the ADMS interface is
used in the Mapper; the second option allows you to choose the coordinate system from
an extensive list of options.

You should choose a map coordinate system that is compatible with the ADMS
coordinate system.
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B Mapper - O X
Project Edit View Layer Tools Settings Help
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Save A
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Figure 32 - The coordinate systems options in the Edit menu.

If the Set map coordinate system option is selected then a new window appears, as shown
in Figure 33, where the coordinate system can be chosen from an extensive list of
options. To select a Projected system, click on the radio button and then choose the
system from the drop-down list.

Rather than scrolling through the entire list of options to find your desired choice you
can click in the box and type the name of the coordinate system you wish to use. For
example, to quickly find the Ordnance Survey grid for Great Britain type OSGB. You can
also type part of the name and then click on the drop-down arrow to see a shorter list of

options.
Coordinate System >
{+ Projected system:
05GB36 British Mational Grid (epsg: 27700 ﬂ
(™ Geographic system:
D5GE36 (epsg:4277) J

™ Turn off (unknown system)

CK | Cancel |

Figure 33 - Choice of the coordinate system

A Geographic system can be chosen in a similar way to a Projected system.

If you wish to use the Unspecified regular Cartesian grid from the model interface, i.e. if
the coordinates are site specific, for example distances relative to a source centre, then
the Turn off (unknown system) option must be chosen.

Mapper User Guide Page 58



SECTION 5 — Additional features

5.2

5.3

Adding a background map

Background maps can easily be added to the map view window in the Mapper. This is
done using the Add background map button on the toolbar. This uses a WMS link to add a
dynamic layer to the map view. See Section 5.4 for more details.

Step 1 Check that a valid coordinate system has been set for the Mapper. See Section
5.1.

step2  Click on the Add background map button 4 on the toolbar. Alternatively, you
can select the Add background map option from the Layer menu.

Step 3 A map layer will be added to the Mapper layer panel.

The map service used for the background map will depend upon the BackgroundMap
setting in the [Mapperinterface] section of the parent model’s configuration file. An
example service is supplied with the model install via a Protocol Layer Connector file
(.ttkwp), but you can change this if you have an alternative WMS you would prefer to
use.

Displaying background images

Background images can be added to the map view window in the Mapper. This is done
using the Add Layer button on the toolbar. The add layer feature allows files with a wide
variety of formats to be loaded into the Mapper.

To load an image to use as a background map, the image must be correctly
georeferenced, which can be done using world files or Maplnfo *.tab files. For British
OS Map data, world files are available from the Ordnance Survey website. These
instructions show how to load an OS map tile as a background map using the
corresponding world file to georeference it.

Step 1  Ensure the map tile image file (*.tif) and world file (*.tfw) have the same
name and are in the same directory.

Step2  Check that a valid coordinate system has been set for the background layer.
See Section 5.3.1.

Step3  In the Mapper click on the Add Layer button ¥ on the toolbar. Alternatively,
you can select the Add layer option from the Layer menu.

Step 4  The Add Layer screen is then displayed, as shown in Figure 34. Browse to find
the *.tif file for the map tile, then click on the Open button.

As an alternative to Steps 3-4, the file can be drag-dropped from Explorer
onto the layer panel.
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Step 5

B Add Layer
« v 4 |« 0S(C) » Program Files (x8) > CERC > ADMS-Urban > Data

Organise New folder

3 Quick access
@ OneDrive - Personal Example9
3 This PC

¥ Network

Ss79rtif

v o Search Data »p

@~ [ @

Examplel0

v

File name: | Ss79r.tif

v ‘ Tag Image File Format ("tif;*.tif v

Figure 34 - The Add Layer screen.

The map tile will be added to the map view window. This layer will be at the
top of the Layers tab and will need to be moved down to allow the ADMS
layers to be seen.

5.3.1 Setting the coordinate system for a background layer

To set a coordinate system for a background map you will need to create a *.prj file as
follows. Suppose that the background map you wish to add has the filename map.tif.
Then follow these steps:

Step 1

Step 2

Double click on one of the layers in the layer panel. A new window will

Select General from the left panel to view the layer information, as shown in
Figure 35.
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Figure 35 - The General section of the layer properties screen

Step 3  Click on the Select button next to the Coordinate System cell to bring up the
dialogue box shown in Figure 33.

Step 4  Choose the coordinate system you wish to use in the background layer from
the available list and then click on the ellipsis (...). This will bring up the
Coordinate System Setup screen shown in Figure 36.

You must choose a coordinate system that is the same as, or consistent with,
the coordinate systems used for the other layers.
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Coordinate System Setup
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Figure 36 - The Coordinate System Setup screen.

Sstep 5  Click on the WKT tab. The screen will be similar to that shown in Figure 37.

Coordinate System Setup it

Projected System
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=]

Figure 37 - The WKT tab.

Step 6  Click on Export... and save the file in the same location as the map.tif file with
the file stem map.tif and extension .prj, i.e. save the file with name

map.tif.prj.

The same procedure applies to other file types, not just *.tif files. In general
for a file with name <filename>.ext, where .ext is any extension, the name of
the projected file must be <filename>.ext.prj

Step 7 After you have saved the *.prj file click Cancel to close the three sub-screens

that appeared in the process of creating the *.prj file.
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5.4 Adding background map imagery from a Web Map
Service (WMS)

It is possible to add a background map layer in the Mapper from a Web Map Service
(WMS). The background map imagery can help display and locate your data and
results. There are two methods for adding background map imagery: one is to use the
Add WMS command from the Layer menu to specify a URL to a web map service; the
other is to use a special Protocol Layer Connector file (.ttkwp).

5.4.1 Adding background map imagery with the Add WMS layer command

Step 1

Step 2
Step 3

First ensure that the coordinate systems in the ADMS interface and the
Mapper are set appropriately for the map that you wish to use. For
example, in the UK the coordinate system for the ADMS interface is often
set to OSGB 1936 British National Grid. (Refer to your relevant model
user guide for full details on how to do this.) In the Mapper the coordinate
system can either be set to use the ADMS coordinate system (i.e. the
coordinate system specified in the ADMS interface), or a particular
coordinate system can be defined (e.g. WGS 84). This is done under the
Project menu. See Section 5.1 for full details on how to set the coordinate
system in the Mapper. Also ensure that all the coordinates in the interface
are given using the specified coordinate system.

Select the Add WMS command from the Layer menu.

A window appears as shown in Figure 38. Specify the URL for the web
map service and click OK.

CERCMapper

Enter the LRL far the w5 layer

*
Cancel

Figure 38 - The Add WMS Layer window.

Step 4 The map will be displayed. The layers may need to be reordered to view

the map and other layers properly (see Section 1.7.4). An example is
shown in Figure 39.
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5.4.2
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Figure 39 - Background map imagery in the Mapper; © OpenStreetMap contributors

www.openstreetmap.org/copyright.

For best results, Map layers and data layers should use the same coordinate system.
Some coordinate systems may not be mutually compatible.

Adding background map imagery using a Protocol Layer Connector file

Alternatively a background map may be added by using a Protocol Layer Connector
file as described here. An example file is included in your ADMS install directory: this
links to the OpenStreetMap WMS.

Step 1

Step 2
Step 3

Ensure that the coordinate systems in the ADMS interface and the Mapper
are set appropriately for the map that you wish to use. (Refer to the
relevant model user guide and Section 5.1 of this user guide).

Click on the Add Layer tool ¥ .

Navigate to the directory containing your *.ttkwp file. Select Files of type:
Protocol Layer Connector (*.ttkwp) to display the files:
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@ Add Layer
1 » ThisPC > Local Disk(D) » Example
Organise v New folder
MName
st Quick access
|| OpenStreetMaps Global TMS.ttkwp
@ OneDrive - Personal
[ This PC
¥ Network

v @ | Search Example

File name: | OpenStreetMaps Global TMS.ttkwp

= N

Date modified Type Size
06/0 TTIWP File 1KB
~| | ADMS-Urban comman files

X
¥

Figure 40 - Selecting Protocol Layer Connector files.

Step 4 Select a (*.ttkwp) file that covers the geographic location of your sources

Step 5

and click Open.

As an alternative to Steps 2-4, the file can be drag-dropped from Explorer

onto the layer panel.

The new layer will be displayed in the Mapper. By default, the view is
zoomed to the full extent of the new layer (Figure 41). The layers may
need to be reordered so that the background image does not obscure the
view of the other layers. Information on reordering layers can be found in

Section 1.7.4.

Contact the CERC helpdesk for help setting up *.ttkwp files for other

maps.
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£ Mapper
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Figure 41 - New layer in the Mapper; © OpenStreetMap contributors
www.openstreetmap.org/copyright.

Step 6 Select the output grid extent or largest source layer and select Zoom to

Iayer?i.

Step 7 This will zoom to the correct location on the map (Figure 42).

5 Mapper
Project Edit View Layer Tools Settings Help
L/9F %Y YL ®RR_A3GV e » | @av U
Layers | Grouping D % %f == = =
37 ot m 27 Prince Willlaery —~ A1134 =
aint sources |
® 5 Court P =
7 " e s,
B [¥ Line sources (0] £ 7
Murkett g
B[ Road sources (8) T : Z:, ,,z(
Castle Park- %
B ¥ Area sources (0) "
av \}olume sources (0)
. A1134
=] W?Id source cells (0) Caktie Mound
= [Z Output grid extent L o/ A
/ - O 4
B[ Output grid points (961)
+ A »
[V OpenStieetMap Tiles A1134
N
s
A1134
5 =
ity 1
) |
Map: 0SGB3E British National Grid (epsg:27700)

- a X
AalimedoC|BE (e~

A1134 g '

A1303 A

A1134 ;

e - Mitchan's™ o Roy
~_=Corner 3 I :

a é

88 BF <

P

41303 Coppuuaiil i Iz S

4 3 &

3 Py

X -]

Jesus College
(University

L
(if ((m:bzggr‘)

Round Church
SLaorner

o Lane jor
o e
o

3

€5us (ang

—— King suet s T v
e sqirall :
e Ware Sy 4
hrist’s Jiry
ORY L FALLE £
- . W\ of Cambridge) & o
b ¥ u & dood
Cly 1 ' £200m <
= L€ > & 4 fon

X: 54464591 Y: 253414.2 | Editing: none Scale: 1:8,500 Y

Figure 42 - Background image displayed in the Mapper; © OpenStreetMap
contributors www.openstreetmap.org/copyright.

For best results, Map layers and data layers should use the same coordinate
system. Some coordinate systems may not be mutually compatible.
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5.5 Displaying data layers

Data from external files can be displayed in the Mapper using the Add layer toolbar
button. Recognised formats such as ESRI shape files (.shp) and MapInfo Interchange
Format files (.mif) will be displayed automatically, but generic delimited data files such
as comma separated variables (.csv) will first prompt you to define data fields as well as
selecting the data that you wish to display.

Data layers created from files are not editable, but their appearance can be modified as
outlined in Section 4.

5.5.1 Using drag and drop

When you are selecting data files to add to the Mapper you can click on the Add layer
tool ¥, and browse to the file.

Alternatively you can locate the file that you wish to add to the Mapper in Windows
Explorer, click and drag it to the layer panel of Mapper. If the file is a recognised
format it will then be added immediately, otherwise further steps need to be followed
as detailed in Section 5.5.3.

5.5.2 Data from recognised file formats

If you choose Add layer and select a file in a recognised format, such as an ESRI shape
file (.shp), the Mapper will automatically display it in the map as a new layer.

This applies to all supported vector files; see Appendix A.3 for a list of recognised file
types. For pixel (image) or grid files, see Section 5.2.

Step1  Click on the Add Layer tool ¥ . A new window will appear as shown in Figure
43.

@Add Layer b
= v 4 » ThisPC » Local Disk (D:) » Example v O Search Example »

Organise » Mew folder =~ [ @

MName Date modified Type Size
st Quick access

@ OneDrive - Personal
[ This PC

£ Network

File name: v| Common files ~

Figure 43 - Add Layer window.
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Step 2
Step 3

Step 4

Change the file type from Common files to ArcView Shape Files (*.shp).

Navigate to the file you wish to view and click Open. The data will then be
displayed in the Mapper as shown in Figure 44.

As an alternative to Steps 1-3 you can use drag and drop.

5 Mapper - m] X
Project Edit View Layer Tools Settings Help

L9PFEXIRTIBTRAGD e »|@ad | a-buBudOC | EBE 9D

Layers Grauping el I§f %&@E}b g :‘%\@:ﬁv . oy \%E. § g :g F G‘ fg}]‘\ﬁ?ﬁ
= i.ildu-.g_r-._hnn-.i:::::mg:z: (}Zf elaé, Qo_s 4%'%”0#"’& ooggg,_:.i . «?Gh .
B [w Faint sources (0] e %5;’&% N $ 4t é} & l & jgp © ';‘
szne sources (0] > \(wy ) A 3 a \
O% Road sources () S % p .

B [ Area sources [0]
V|

B [ Yolume sources (0]
A

B [v Grid source cellz (0]
&L

ADMS Urban | Yiew |

Map: UNENDWN [epsg:0) P( 5.4442211E+05 ¥: 25780905E+05 |Editmg: nong ‘Scale 110900

Figure 44 - Data from the shape file displayed in the Mapper.

Information about the data can then be viewed. Select the information tool @
and click on one of the shapes. (Full details on the information tool can be
found in Section 5.6). Information is then displayed in the Attributes table, as
shown in Figure 45. The information available will depend on the file type
and the file data.

It is possible to colour and label shapes according to their properties. See
Sections 4.6 and 4.7 for further details.
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5.5.3 Data from CSV and other delimited text files

bMapper
Project Edit ¥iew Layer Jools 3Settings Help

% PY% BTIRTRRQIDe» @ad AL uBRNSOC | EBE WD
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S 3
A

Map: UMKHOWN [epsg:0)

5 B ATA027E 405 v: 25307014E+05 |Editing: none | Scale: 1:10.800 |

Figure 45 - Information from the numerical data displayed in the Mapper.

If you display data from a CSV file or unrecognised text file, the Mapper will attempt
to load it into a layer, providing an intermediary window for selecting data from the
file. If the file contains a header line, the Mapper will attempt to find it and identify
the start of the data lines; otherwise you need to manually enter the column headers.

Data can be displayed as points, polylines or polygons but must be identified as such
in the column headers by following a specific naming convention, while all other
columns are treated as properties. In each case this can be done in the file or in the
Mapper data window:

*  For point layers, there must be an easting and a northing named appropriately in
order to display the data.

The easting must be named as one of X, X(m), or X (m)
The northing must be named as one of Y, Y(m), or Y (m)

The elevation will be recognised if it is one of Z, Z(m), Z (m), or
ELEVATION. Elevation can also be set to any column by right clicking
the column header and selecting Set as elevation field. To clear, right click
on the elevation field again and select Clear elevation field.

*

*

*
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B Select data to use in layer: ExampleS.plt O *
File: D:\E xampleshExampleb. plt Lines: 3
Start line: |2 End line: |3 v End of file Delimiter: |, Reload
Receptor ) *[m) Zlm) Conclug/m3| Conclug/m3|| Conclug/m?3] ~
# Receptor nar | #[m) *f[m] Zlm Conicly=i=ME sl i h] Lol te 3l
1 Receptor nar|#[m) f'[m) Z[m) Concl. Set as elevation field
2 Abbey 544867.00 |258805.00 |.00 0.6047 Clear elewatinm fi
Cl levation field
3 Gohool 54451000 | 25302200 | 00 02632 SEreeEen e
v
A 3
0 Gotoline | Corwert data to arid using: Matural Neighbour + oK | Cancel

Figure 46 - Setting the Elevation field in the Mapper.

*  For polyline layers, at least two appropriately named vertices must be supplied in
order to display the data.

*

*

For the start point, the easting must be named as X1 and the northing must
be named as Y1

For the next point, they must be named as X2 and Y2 respectively

Subsequent points can be provided, continuing the naming sequence. For
each point both X and Y must be provided and they must form a
continuous sequence starting from 1.

The elevation must be named as one of Z, Z(m), Z (m), or ELEVATION

*  For polygon layers, at least three appropriately named vertices must be supplied in
order to display the data.

*

For the start point, the easting must be named as pX1 and the northing
must be named as pY'1

For the next point, they must be named as pX2 and pY2 respectively
For the next point, they must be named as pX3 and pY 3 respectively

Subsequent points can be provided, continuing the naming sequence. For
each point both pX and pY must be provided and they must form a
continuous sequence starting from 1.

The polygon will be closed automatically, so the first and last vertices must be
in different locations.

*

The elevation must be named as one of Z, Z(m), Z (m), or ELEVATION
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The data window — shown in Figure 47 — has the following options for data selection:

*  The option to enter the Start line and End line (or select End of file). The delimiter
can also be entered.

*  An editable header line (yellow background) lets you choose which columns are
included as properties in the layer. Columns that have ‘-> or whitespace for their
header not included as layer properties.

* A right-click menu on the # column that has the following options:
*  Set as first data line — selects a new data start line.
*  Set as last data line — choose a new data end line.

*  Copy to header — replaces the contents of the editable header line with the
selected line.

*  Go to line button — Brings the line specified in the box to its left into view in the
table.

*  Reload button — Refreshes the table

*  Convert data to grid using: — check this option at the bottom of the data window if
you require a *.grd file of your data. Once the selection box has been checked,
set the grid field by right clicking the mouse over the relevant column of data.
Then press the OK button.

B Select data to use in layer: Examplel.gst O s
File: D:\Examples\Example.gst Lines: 2884
Start line: |2 Endline: |2884 ¥ End of file Delimiter: |, Reload
‘Year Day Haur Timels] ] Yiml [ Zim) Conclug#m3| ~
# ‘Vear Clay Haur Time[z] #[m] *r'[m] Z[m] Conclugs/ma3]:
1 “ear Diay Hawr Tirne(s] #lm) ') Zlm) Conclug/m3|!
2 1 -999 -959 -999 .0a -200.00 0o 0.500000E +C
3 1 -939 -339 -933 106.67 -200.00 .00 0.500000E+C
4 1 -939 -339 -993 213.33 -200.00 .00 0.50847EE+(
L] 1 -939 -339 -933 320.00 -200.00 .00 0.EE077A4E+(
b 1 -999 -939 -999 426.67 -200.00 .00 0.935790E +(
7 1 -999 -959 -999 533.33 -200.00 0o 0.114726E+(
8 1 -939 -339 -933 E40.00 -200.00 .00 0.125684E +(
a9 1 -939 -339 -993 T46.67 -200.00 .00 0.129313E+(
10 1 -339 -333 -933 853.33 -200.00 .00 0.128721E+(
11 B - =4 939 95000 -200.00 .0g 012597 3F +L
12 Set as first data line ] 959 10BEE7  |-20000  |.00 0122240 +1
13 Cet s last data line § 993 117333 20000 |.00 011818664
14 8 -993 1280.00 -200.00 .00 0.114130E+(
15 Eopyjiolieadsy § 593 138667  |20000 |00 0.110235E+0
16 1 999 -39 -999 1493.33 -200.00 .00 0.106597E+(
17 1 -999 -959 -999 1E00.00 -200.00 0o 0103235 +(
18 1 -939 -339 -933 1706.E7 -200.00 .00 0.1007148E+(
19 1 -939 -339 -993 1813.33 -200.00 .00 0.973414E+(
20 1 -939 -333 -933 1520.00 -200.00 .00 0.947734E +( A
4 3
a Gotoline | Coreert data to grid using: Matural Meighbour 0K Cancel

Figure 47 - Data window

Suppose that you wish to display data from a tunnel file Tunnels.csv alongside data in
Example6b.upl (these examples files are not supplied with ADMS 6). Ensure that the
UPL file is loaded and follow these steps:

Step1  Click on the Add Layer tool¥. A new window will appear as shown in
Figure 48.
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B Add Layer X
5 v 4 > ThisPC > Local Disk (D) > Example ~ @ | Search Example P
Organise + MNew folder - I @
~
Mame Date modified Type Size
3 Quick access
No items match your search.
@ OneDrive - Personal
> O This PC
¥ Network
File name: ~ | Commeon files v

Figure 48 - Add Layer window.

Step 2  Change the file type from Common files to All Vector Files.

Step 3 Navigate to the *.csv file you wish to view and click Open. A new window
will appear as shown in Figure 49.

B Select data to use in layer: Tunnels.csv O X
File: D:ExampleshTunnels. cav Lines: 4
Start line: |2 End line: |4 Iv End of file Delirniter: |, Reload
A B C D E F G H S
¥ HoadT unnef
1 FoadT unnef
2 Mame =1 1 e Ve MHurnTrafficDi|BoreDepthl |PaortalBaseE ) Outflawk
3 Chesterton F|545326.67 | 25948059 | 544F06 259056 1 -1 -1 none
4 tagdalene 5/ 544F08 2h3056 544788 2R8B80 2 4 a Castle 5
]
4 3
i] Go ta line [ Conwvert data to grid using: M atural Meighbour = oK Cancel

Figure 49 - Data from Tunnels.csv

Step 4  This window can be used to select which data you wish to display in the
Mapper. See Section 3.4 for an example that requires data selection.

Step 5  Once you have selected the data that you wish to display click OK. The data
will then be displayed in the Mapper as shown in Figure 50. The default line

appearance is a thin black line.

Mapper User Guide Page 72



SECTION 5 — Additional features

Step 6

B Mapper

Project  Edit View Layer Tools Settings Help

LOFX ML ®EREA GO e

Layers Grouping 30
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B v Road sources [8]
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+

Map: 0SGE3E British Mational Grid (epsg: 27700)
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AT E

2 54423225 : 259551.34 | Editing: none

200 m

Scale: 1:8500

Figure 50 - Data from the Tunnels.csv file displayed in the Mapper.

Information about the data can then be viewed. Ensure that the data layer is

selected in the layer panel. Select the information tool @ and click on one of
the data points. (Full details on the information tool can be found in Section
5.6). Information is then displayed in the Attributes table, as shown in Figure
51. The information includes all of the columns shown in the data window.

for further details.

It is possible to colour the data according to its properties. See Section 4.6

@ Mapper

Project Edit View Layer Tools Settings Help

LIPFX B BERQAD @

Layers Grouping 30

B [v Point sources (0]

°

B ¥ Line sources (0]

B [ Road sources [8]
Ve
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L

O [ Output grid estent
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Layer Turngls
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| View |
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#: 54442334 Y 253465.91 | Editing: none

200m

Scale: 1:8.500

Figure 51 - Information from the Tunnels.csv file displayed in the Mapper.
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5.6

Information about a feature

The Mapper allows you to view information about a model feature or a raster layer from
within the Mapper. To display the information about a model feature, follow these
instructions.

Step1  Click on the Information button on the toolbar. @
Step 2 Then click on the feature in the map view window.
Step 3 Information will be displayed about the feature in the attributes table, as
shown in Figure 52.
@ Mapper — [m] x
Project Edit View Layer Tools Settings Help
LI2F (BT MRAQTOH @as|--kah EL(wd-
Layers Grouping 30 A
B [ Line sources (0]
B [ Road sources [0]
B[ Area sources (0
B [¥ Volume sources (0] .
uiD 1
Layer Foint sources
Mame Source 1
Geometry Fint
Velices 1
Elevation o0
Diameter 35
W 0
v 0
Temperature 855
Exit velocity 29
s02fgfs 85
GIs_aREA U
GIS_LENGTE © [ ]
soMsUtan | view T
Map: UNENDWH [epagi0] % 2507.3985 Y: 1817 417 | Editing: none Scale: 1:26.100
Figure 52 - The feature information screen for a point source.
Step 4  Click on the model name button (e.g. ADMS) to be directed to the feature in
the model.
Step5  Click on the View button for the feature to be highlighted in the Mapper.

Holding down AltGr ensures that only features in the currently selected layer can be
clicked.

To display information about a raster layer containing data values, including any
contour plots created with the 2D output plotter, follow these instructions:

Step 1  Ensure that the raster layer is selected in the layer panel
Step 2 Click on the Information button on the toolbar. e
Step 3 As you move the cursor across the raster layer, the value at that point will be

displayed on the right hand side of the status bar, as shown in Figure 53.
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Step 4

Hold down AltGr and click on the raster layer to display the value and X, Y
coordinates at that particular location in the attributes table, also shown in
Figure 53.

B Mapper

Project Edit Wiew Layer Tools 3Settings Help

Zo¥ BT EA A0 0Ll B-uARNSOC|EL WS-

Layers

Grouping 30

7/
Bl [+ FRoad souces (0]
B [ Area sources (1)
B W Volume sources [0]
B v Grid source cells (0]
B[ Output grid extent

B Output grid points [361]

+
B ¥ 502 ug/m3 contours

1233.68

ADMEUtban | Yiew

300

Map: UNKNOWM (epsg:0) [ ¥ -376,62183 Y 2874.7316 |Editing. none

[scake: 128900 |

Figure 53 - The feature information screen for a raster layer.

Mapper User Guide

Page 75



SECTION 5 — Additional features

5.7 Measuring distances

The Mapper comes with a tool that allows you to measure the distance between two or
more points in the map view window. Follow these instructions to measure distances in
the map view window.

Step1  Click on the Measure button on the toolbar. ¢

Step2  Click on the map view window at the first point of interest, and then click on
a second point. A dotted line is produced between the two points of interest
and the distance between the two points is shown on the status bar in the
bottom left hand corner of the Mapper window, as shown in Figure 54,

B Mapper - m} *
Project Edit Wiew Layer JIools Settings Help
2% %z Gy de 8 ale v ! EL wd -

Layers Girouping ES)

B [w Paink sources [U]

B [v Specified paints (1]
=]

-*

250m

Distance: 424 43 metres X 273653 84 Y- 19803506 | Editing: none: Scale: 1:8.470

Figure 54 - Measuring distances in the Mapper. The distance is given in the bottom
left corner.

step 3  Clicking on further points adds further lines and the cumulative distance is
displayed in the status bar.
Step 4  The position of the points can be modified as follows:

e To add a point, click on the existing point that lies before the desired location
of the new point and then click where you want the new point to be.

e To move a point, click on the point, and while holding down the mouse button,
move the cursor to the new location for the point before releasing the mouse
button.

e To delete a point, first click on the point to select it, and then click on it again.

The points that the distance is being measured between appear as coloured
squares. The current selected point is red and the other points are green.

Step 5  Toremove all the defined points whilst using the measuring tool, double click
anywhere in the map view window.
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5.8 Displaying the north arrow and scalebar

It is possible to toggle the display of an arrow in the Mapper that indicates the direction
of north and the scalebar, see Figure 55 . These indicators are only displayed when the

plot is in 2D mode.

@Mapper
Project Edit Yiew Layer Iools Settings Help

9 ¥ @. ﬁ Snap to shape

~  Display scalebar

Lapers Grouping an
~  Display north arrow

Bl [v Puoint sources (1) Gridding option

Bl [v Line sources (0] Save all layer settings as default

B ¥ Road sauces (0] Restore factory se‘i‘tlngs

B [v Area sources [0)
A

B v Yolume sources (0]
A

B [v Grid source cells (0

B ¥ Output grid extent

B [v Output giid points [961]
+

tap: UMEMOWHN [spsg:0)

EL wd-

400

»: -B58.11808 : 892.98893 | Editing: none Scale: 1:15,300

Figure 55 - The north arrow and scalebar are displayed in the top and bottom right-hand
corners, respectively, of the map window.

To toggle the indicators, select/deselect the Display north arrow or Display scalebar option

from the Settings menu as desired.
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5.9 Viewing features in 3D

Features in the Mapper can be viewed in 3D. This can be especially helpful when
checking building or source heights, or when examining complex terrain, variable
roughness or concentration fields.

To see a 3D visualisation of the features in the Mapper first click on the Change View
icon™. After doing this, the map view will change and the Change View icon will also
change. To return to the 2D planar view, click again on the new Change View icon}~.

When in 3D mode, three axes are shown: vertical (blue), east-west (red) and north-south
(green). By clicking and holding the mouse you can rotate the map to examine the 3D
visualisation from various points of view. A new button appears which enables you to
change the method of panning the camera — the options available are summarised in
Table 4.

See for example Figure 56 which shows a view of buildings in the Mapper when in
standard mode and when in 3D mode.

B Mapper - O x| |®Mupe

Broject Edit Wew Layer Took Sedfings Help Project Edt Yiew Layer Jook 3 :
PR R AL R AL-A- T IE R R A El wd- 9% RY - RN
Layers Grougwng | |

T 158 Y- 767 ASI0T |Edbing rere | ek 115300 Map UNKNOWN (2peg 0) Edrg moe | Scae 11590

Figure 56 - Buildings viewed in 2D and 3D modes.

Some layers will have both a height (Z) and a depth (M), for example a building can
be at a terrain height Z, with a depth of M.

The vertical scale can be exaggerated using the Scale Z (%) and Scale M (%) options in the
3D tab. This may be required for clarity if the horizontal extent of the modelling region
is much larger than the vertical extent of the buildings, sources, terrain, etc.

5.9.1 Options in the 3D panel
When in 3D mode the view can also be changed a variety of ways by using the options
under the 3D tab in the layer panel.

e Vertical, Horizontal and Distance — allows manual setting of the position of the
camera in spherical coordinates. The + and - buttons change the distance of the
camera from the origin of the X,Y,Z axis.

e Reference point — positions the origin along the Z axis (altitude) relative to the
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layers shown:

e Base — if there is at least one layer which is a digital elevation model
(DEM), then the base is set to the lowest Z value found in the DEM

e Zero — the value is set to zero regardless of the Z coordinates found in the
open layers

e Lowest — lowest value of all Z coordinates in all the layers
e Highest — highest value of all Z coordinates in all the layers

e  On DEM - the value of the Z coordinate read from the DEM at the longitude
and latitude of the origin pointer; this does not change if the origin pointer
changes

e Fly on DEM — as On DEM, but the value updates if the position of the origin
pointer changes

e Lights — toggles the directional light on/off

e Shadows — sets the intensity of shadows when the directional light is turned on;
varies from 0 (no shadows) to 100 (darkest shadows)

e Base plane — toggles a base plane on/off
e  Wireframe — toggles the wireframe display mode on/off
e Edges — toggles edges on/off on the 3D objects

e Scale Z (%) — scales the height (Z) coordinate of all open layers; 100 is the actual
size

e Scale M (%) — scales the depth (M) coordinate of all open layers; 100 is the
actual size

e  Flood — toggles on/off a floodplains simulation; the numerical value is the flood
level (in metres)

e Wall - if there is at least one digital elevation model (DEM) among the open
layers, this option sets the appearance of the DEM boundaries:

e Off —no DEM walls
e  Colour — grey walls with contour lines

e Texture — textured walls with contour lines
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5.10 Copying the map view window to the clipboard

To copy the current view from the map view window select Copy map to clipboard from
the Edit menu. This image can then be pasted into a document or picture editing
software and saved.

The Copy legend to clipboard option from the Edit menu can be used to copy an image of
the layer panel to the clipboard. If only a part of the layer panel is required, for instance
the legend for a contour plot, then the image should be pasted into image processing
software and then cut down as appropriate.

The Attributes section of the layer panel is not copied to the clipboard.

The Copy scalebar to clipboard option from the Edit menu can be used to copy an image of
the scalebar to the clipboard.

5.11 Layer statistics

Statistics about a particular layer can be viewed using the Layer statistics tool. Namely,
the minimum, maximum and X, Y location of each are reported for each numerical field
in the layer. Up to five filters can also be applied to the layer to constrain the number of
features/data points on which to calculate the statistics.

To view the statistics for a particular layer, right click on that layer in the layer panel of
the Mapper and select Statistics. This brings up the Display statistics screen, as shown in

Figure 57.
B Display statistics: Examplel (967) - O *
Filters
Naone x| = |None J
|None j = |None J
|None ﬂ = |None J
|None j = |None J
|None ﬂ = |None J
Copy |
Field Minimum [ Y e E3 s ~
p [GeometrylD s I ﬂl[multiple] [multipl=] 1 ﬂ'[multiple] [multiple]
Yertices s I % [ruiltiple] [multipl=] 1 B [rruiple] [multiple]
Elewation ) Lt B [ruilkipl=] [multiplz] i} B [rmuliple] [rultiple]
Depth | L ﬁj[multiple] [multiplz] 1] ﬁj[multiple] [multiple]
Width i) Lt ) [ruilkiple] [multiple] i} B [ruliple] [multiple]
Diameter ) LU | [muiltiple] [multipl=] a 4| [rmultiple] [multiple]
= T L % [ruiltiple] [multipl=] 3200 B [rruiple] [multiple]
Y [f4)-200 B [ruilkipl=] [multiplz] 3200 B [rmuliple] [rultiple] v
=1 71 DA [T El T T TR
Close

Figure 57 - Display statistics screen

You can use the Filters section to apply up to five filters to the data in this layer, for
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example you may want to view the statistics for only those points in a .pst file that
correspond to the first line of meteorological data and/or have a receptor height of 2 m.
Whenever the filters are modified, it is necessary to click the Refresh button for the
changes to take effect.

Other useful features include:

e The Copy button can be used to copy the entire table to the clipboard, which can
then be pasted into a text editor (e.g. Notepad) or spreadsheet package (e.g.
Microsoft Excel).

« Similarly, the I buttons can be used to copy the statistics for a particular field to
the clipboard. If there are multiple X, Y locations where the minimum or
maximum occur for that field, the data for all locations will be copied, thus
expanding on the information shown in the table.

e The X, Y location(s) of the minimum or maximum can also be highlighted in the
map view window using the relevant binoculars icon A For example, this can
be used to identify the location(s) of the lowest and highest concentrations in a
.glt file, as demonstrated in Figure 58.

Took Settings bk

ot e Wew Laper J
i ¥ VT ARAa e [ g - EL owd-

[Mom URHOWN gty 30111255 . 2500406 [Ecng rove | Scae 126000 _| |Mop UNKNOWH Pprgth . 45790680 Y. 2762 7675 iy rere [ Scske: 126100

Figure 58 - Displaying the minima (left) and maxima (right) of a .glt field
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6.1 Extract data tool

If a raster layer has been added to the Mapper, it is possible to extract the data from this
layer into *.csv format. This can be achieved through a simple process, although there
are more advanced options to satisfy precise requirements for the output data.

6.1.1 Using the Extract data tool
This can be done by following these instructions.

Step 6  Add the raster data file to the Mapper. In this example, an OS terrain 50 file
will be added, and a section of the terrain data extracted for use with ADMS.

5 Mapper - a X
Project Edit View Layer Tools Settings Help
T/9¥X(BL[ARR_JO ¢ »0a9 H-AANARSOC[EL(OD

Layers [ Grouping aD

B 1052
=
54
[]m
104
1231
[ 1542

B 1792

I 2043 o

— B8 " !

B [V Point sources (0) LA
L]

E [V Line sources (0)
/ ‘
E [V Road sources (0]

B [v Area sources (0]
A

B[V Yolume sources (0)
4

B [v Grid source cells (0)
AL

[ & NSNS

2000

Map: UNKNOWN (epsg:0) . 5.4851568E+05 \: 1.2918081E+05 | Editing: none Scale: 1:76,700

Figure 59 - Mapper showing an OS terrain 50 file, which has been coloured by
terrain height.

Step7  Press the button Extract data from raster layers,<3, to bring up the Extract data
screen. Alternatively, you can select the Extract data from raster layers option
from the Tools menu.

Step 8  The Extract Data Extent is now displayed in the map as a new layer. By
default, it covers the whole of the current map view window. If you wish to
change the extent, you can redefine, move or edit it using the standard
Mapper editing tools (see below). Alternatively, you can edit the extent
manually in the Extract data screen.
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Step 9

BMappev
Project Edit View Layer Tools

Settings Help

ZI9¥ % BT €E2eR_3GV0 ¢ 3| Qay B-AHNARSOC (BEIOD-

Layers Grouping 3D

B [V Extract Data Extent

BV 1852
2
[ ]54
[
1041
=] 1291
[ 1542
[ 1792

I 2043
I 2293

B [v Point sources (0)
L]

E [v Line sources (0)

B [v Road sources (0)

B [V Area sources (0)

B [v Yolume sources (0)

B [v Grid source cells (0]
AL

ADMSUiban |

2000

Map: UNKNOWN [epsa:0)

’ X: 5.50119E+05 : 1.3001292E +05 ‘Ediling: none

|Scale: 176700

Figure 60 - Mapper showing the Extract Data Extent as a red rectangle.

Check the selected data layers and customise output data options if necessary;
see Section 6.1.5 for a description of the available options.

Extract data
— Layers
TOA2 v 1 50 50 - a ArcdInfo ASCI Grid Format [GRD). 20
— Output col — Output extent
W write header W Include index column Al
e 5 v Z Mini< -] |548EI49 bin ™ [-] |1195DD
Output type bax 3 [-) |581 951 Manr -] I‘I 30500
* Data " RGB [T RGBA [hexadecimal] v Extentl 13902 | v Extent| 11000 |
[~ ARGE [integer)
— Dutput sp q
— Coordinate system
[Map - UNKNDWH (epsa] ~| (| [T23 02442672 vulizs
~ Missing data wp| 120 | v 1o |
[~ Add values for mizsing data points Paints in ><| 113 | Paints in Y| 1o} |
Default data value| ID Total pointsl 9944 | §I
Refresh I Create | Cloze |
Laver name Min: | M au: |

Figure 61 - Extract data screen

Step 10  When you have confirmed all the settings are as you desire, click Create. You
will be prompted to enter the name of the output file. Once the file has been
successfully created, a notification dialog will inform you of the number of
points written to the file.
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Step 11

Extraction complete X

'0' Successfully extracted 8480 points

Figure 62 - Notification of successful data extraction

If you have been making changes in both the Mapper and the Extract data
screen and you want to ensure they are synchronised before continuing, you
can click the Refresh button.

The resulting output *.csv file can be added to the Mapper or viewed in a text
editor (e.g. Notepad) or spreadsheet package (e.g. Microsoft Excel).

6.1.2 Redefining the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Select the Extract Data Extent layer from the layer panel.
Click on the Add Feature button on the toolbar to select it. Ld

Click on the location of one corner of the extent in the map view window, and
while holding down the mouse button, move the cursor to draw the extent
required before releasing the mouse button.

A new extent has been defined and the Output extent section of the Extract data
screen will have been updated automatically to show its new coordinates.
These coordinates can now be manually adjusted further if desired.

6.1.3 Editing the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Select the Extract Data Extent layer from the layer panel.
Click on the Edit Feature button on the toolbar to select it. <1

Click anywhere within the current extent. Three of the extent vertices will
appear as green dots and the fourth vertex as a red dot.

The vertex with the red dot indicates which corner of the extent will be
movable. To select a different vertex, use either the full stop (.) or comma (,)
keys on the keyboard.

Click in the map window, and while holding down the mouse button, move
the cursor until the red grid vertex is in the desired location before releasing
the mouse button.

Click on the Save Edits button on the toolbar to save the changes to the Extract
data screen. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.
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6.1.4 Moving the Extract Data Extent

Step 1
Step 2
Step 3

Step 4

Select the Extract Data Extent layer from the layer panel.
Click on the Shift Feature button on the toolbar to select it. £3

Click anywhere within the current extent, and while holding down the mouse
button, move the cursor to the new location for the extent before releasing the
mouse button.

Click on the Save Edits button on the toolbar to save the changes to the Extract
data screen. 4. Alternatively right click the mouse to bring up a pop-up menu
and select the Save edits option.

6.1.5 Extract data options

There are a range of options that can be used to customise the extraction of data
including altering the location, spacing and coordinate system.

*

Basic options:

*  Choose which Layers to extract data from. Layers that overlap the selected
area are included by default. In general, layers with a single data band (e.g.
OS terrain data) and layers with multiple data bands (i.e. Red-Green-Blue
raster data) should not be included at the same time.

*  Choose whether or not to write a header row to the data file by selecting or
deselecting the relevant checkbox. If you choose to write a header row, the
column headings can be edited.

= Select whether or not to include an index column.

When creating an ADMS format terrain file, it should not have a header row,
but an index column should be included.

*  Select whether to extract the data with a single band (e.g. elevations) or with
multiple bands (e.g. RGB values). If RGB values are selected then
additionally chose whether to also output RGBA (hexadecimal) or ARGB
(integer) values.

*  The Output spacing should be set to the required resolution in the X and Y
directions. You can specify a different spacing in each direction if required.
If the output spacing entered would result in more than this number of
output points it is automatically reset to the nearest value that reduces the

number to within tolerance. You can also use Total point target option, ﬂ to
specify an overall number of points to use. This option will set the spacing
to give a total number of points as close to the target as possible while
maintaining the current ratio between the X and Y spacings.

Additional options:

*  The Coordinate system for the output data can be selected. By default this is
set to the ADMS coordinate system, but it can be changed to match the
raster layer or map coordinate systems.
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When creating an ADMS format terrain file, the coordinate system should
match the ADMS model data that it will be used with.

* |t is also possible to manually edit the Output extent in the Extract data screen
if you wish to change the selected range of X and Y coordinates. To do this,
type in the Min X, Max X, Min Y and Max Y values in the boxes provided. This
will automatically update the Extract Data Extent layer in the map view
window.

*  Some layers can have regions with no data; you can specify the value to be
entered in these regions, e.g. some formats of terrain data files do not report
values over areas of sea, and in this case the terrain height should be set to
zero.
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6.2 Export features

The Mapper layers can be exported to a variety of formats. Some popular formats
available are

ArcView Shape Files (*.shp)

Autocad (*.dxf)

Digital Line Graphs (*.opt) — line sources only
Geographic Markup Language (*.gml)
GPS Exchange Format (*.gpx)
Keyhole Markup Language (*.kml)
MaplInfo Interchange (*.mif)

Portable Network Graphic (*.png)
JPEG File Interchange Format (*.jpg)
Tag Image File Format (*.tif)
Windows Bitmap (*.bmp)

To export a layer into any of these formats first click on the layer in the layer panel to
select it. Then click on the Export Layer button on the toolbar ¥a. This brings up the
export layer screen, as shown in Figure 63. Select the file type you wish to export to,
give the file a name then click on the Save button.

B Save Layer
« =2 v 1 » ThisPC » Local Disk (D) » Example
Organise New folder

Name Date modified
3 Quick access

@ OneDrive - Personal
[ This PC

¥ Network

File name:

Save as type: | ArcView Shape Files (*.shp)

~ Hide Folders

Figure 63 - The Export Layer window.

Alternatively a layer can be exported by selecting it and then right-clicking to display
the menu. Select Export layer and then select the file type from the sub-menu which
offers four formats, to SHP..., to KML..., to CSV... and for SPT..., for data layers containing

points, polylines or polygons including ADMS layers.

With the first three of these options, a new window will appear which you can use to
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save the file in your desired location. The file type will be selected automatically and a
default name for the file is suggested, based on the name of the layer.

The for SPT... option opens a series of forms that automate the generation of comma-
separated .spt (and related) files that can be imported directly into the ADMS models.
See Section 6.2.2 below for more details.

For raster layers, the options are to PNG..., to JPG..., to TIF... and to BMP.... Similar to non-
raster layers, a new window will appear which you can use to save the file in your
desired location. The file type will be selected automatically and a default name for
the file is suggested, based on the name of the layer.

B Mapper - ] *
Project Edit View Layer Jocls Settings Help
R 1 2L/ GReq e Qav| a-cabms B wd-

Grouping

Layers

B v Paint gources (0]
L]

B [ Foad sources (0]

= [ Buildings (3]

. ¢ .
2w Area Settings > . \
Use layer CS for map L )\
B ¥ Yolur \

Move to top

Bl [ Girid 1 Move to bottom
B Outpl Simplify layer
Refresh contours
B v Outpr
+ Export layer > to SHP... Ty

Clip layer to polygons to KML... i

% &
Statistics to CSV... \

for SPT... A

Deselect layer
Remave layer

400

Map: UNKNOWHN (epsg:0] »: 113293358 Y: 397.78598 | Editing: none Scale: 1:15,300

Figure 64 - The Export Layer right-click option.

6.2.1 Exporting to Google Earth

The layers can be exported so that they can be viewed in Google Earth. This may be
useful for checking the locations of sources and buildings etc. against a satellite image
of the area being modelled. To do this, follow these steps:

Step 1  Set the coordinate system for the map, see Section 5.1.

Step 2 Ensure that a valid projected or geographic coordinate system has been set
for the layers that are being exported. Refer to Section 5.2 for details on
how to do this.

The coordinate systems for the ADMS layers do not need to be changed in
the Mapper. These are set automatically from the option defined in the
ADMS interface. The Unspecified regular Cartesian grid cannot be used if you
wish to export an ADMS layer to Google Earth.

Step 3 Export the layer to Keyhole Markup Language (*.kml) by following the
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Step 4

instructions given above.
Open the *.kml file in Google Earth.

6.2.2 Exporting for SPT

Non-ADMS layers containing source information, e.g. a shape file of point or road
source data, can be exported for .spt format so that they can be easily imported into the
relevant ADMS model for inclusion in the dispersion calculations. Once imported, the
sources will appear in the relevant ADMS source layer in the Mapper; the original
non-ADMS layer can then be removed/unticked to avoid duplicating the visualisation
of these sources.

To do this, follow these steps:

Step 1

Step 2

Step 3

Step 4

Right-click on the relevant non-ADMS layer in the layer panel and select
Export layer > for SPT.... This brings up the Export files for SPT form, as shown
in Figure 65.
B Export files for SPT x
Al figlds ~|  Source name field Name «|  Traffic dataset —
e ~ SPT file
{B:gfﬁf] * | Use VR file? [ =] widhidenth |—
{Elieam;itoe:}] Specific heat capacity ’— Canyon height ’—
{Egg;iﬁ;;ty] Malecular mass ,— Angle of elevation l—
{%&iometl}llD] Buoyancy type ’—Ll Horizontal angle ’—
Fr:da;;:guilding] Buoyancy value l— water ratio l—
[Harne] Actual or NTP? ’—Ll Traffic flows used? ’—LI
[MOx [a/5]] i
[T emperature] Efflux type ’—Ll Traffic wear l—
[Wertices]
[Wolume flow rate] v Efflux walue Road type
P fidtial
| Heatrelease rate l— Gradient l—
E’E{Uea} Saurce type <] Main building =
%ﬁ;i‘z%?}} Height l— Comments l—
{LengthCS} Diameter
Expart | Cloze |
Figure 65 - Export files for SPT, SPT file section
Using the drop-down menu next to Source name field, select which of the
fields in the non-ADMS layer contains the source names.
If exporting road source data with emissions calculated using traffic flows,
specify name of the Traffic dataset, c.g. “UK EFT v13.1 (2 VC)” — this
should exactly match one of the traffic datasets used in ADMS-
Urban/ADMS-Roads. If exporting data for a different source type, or road
traffic emissions will be user-defined, this box can be left blank.
Fill in as much of the SPT file section (source properties) as possible. Boxes

can be filled either by using the drop-down menu (where applicable),
typing directly into the box or drag-dropping the name of a field from the
current layer from the list of fields on the left-hand side of the form
(enclosed in square brackets, e.g. ‘[Name]’) into the relevant box. Field
names will automatically be converted to the relevant values for each
source in the layer upon export. Entering a constant value in a box will
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Step 5

Step 6

Step 7

result in every source taking that value for that source property in the .spt
file. Fields that are not relevant/required can be left blank (or filled with
‘na’ or ‘n/a’). Fields that are required in the .spt file for successful import
into the ADMS model but that don’t have an equivalent field in the current
layer can also be left blank, however this information will need to be
manually added to the .spt file after creation before it can be imported into
the ADMS model.

Press Next > to move onto the EIT file section (pollutant emissions), as
shown in Figure 66. If the current layer does not contain direct emissions
data, skip to Step 7.

B Export files for SPT *

Marne & ’—

Pallutant name

Source name field
EIT file

All figlds - Traffic dataset
[Drengity]
[Drepth]
[Criameter]

[E leration]

[E sit velocity]
[Geomety]
[GeometylD]
o]

Emizsion figlds

[Layer]

[t ainBuildirg]
[M arme]

[NOx [a/s]]

[T ermperature]
[Wertices]

[V alume Fow rate] v
P fidtial

#1

#50

{Aeal
ihreals)
{Length}
{LengthCS}

Emizzion factor

Pallutart name

—

| Close |

< Previous | |{

Export

Figure 66 - Export files for SPT, EIT file section

Fill in as much of the EIT file section as possible in a similar manner. Note
that the Emission fields box can only be filled by drag-dropping field names,
the Pollutant name box can only be filled by typing and the Emission factor
box can also be filled by drag-dropping the name of a parameter associated
with the current layer from the list of parameters (enclosed in curly
brackets, e.g. ‘{Length}’) on the left-hand side of the form. The Pollutant
name box should be used to ensure that the pollutant name associated with
a particular emission field matches a pollutant name as defined in the
ADMS model’s pollutant palette The Emission factor box can be used if
emission data in the current layer are not in the appropriate units. For
example, area source emissions should be given in g/m?/s in the ADMS
models, so if the current layer contains area source emission rates in g/s, it
would be necessary to multiply the emission field by the area of each
source, i.e. specify ‘/{Area}’ in the Emission factor box.

Press Next > to move onto the TFT file section (traffic flows), as shown in. If
the current layer does not contain traffic flow data, skip to Step 9.
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B Export files for SPT *
Al figlds ~|  Source name field Mame +|  Traffic dataset —
[Densiy] VT T|me field 3  feld P hill ield Vehicl
[Depth] ehicle count figlds verage speed figlds ercent wphil fields ehicle category name
[Criameter]

[E leration]
[E sit velocity]
[Geomety]
[GeometylD]
[ID]
[Layer]
[t ainBuildirg]
[M arme]
[NOx [a/s]]
[T ermperature]
[Wertices]
[V alume Fow rate] v
Tadict]
#1
#50
{Areal Wehicle count factor |
{reals} . ;
{Length} Wehicle speed factor | Vehicle categony name
{LengthCS} Percent uphill factar |
< Previoug | | Clage

Step 8

Step 9

Step 10

Step 11

Figure 67 - Export files for SPT, TFT file section

Fill in as much of the TFT file section as possible in a similar manner. The
Vehicle category name box should be used to ensure that the vehicle category
name associated with a particular vehicle count field matches a vehicle
category name as defined in the ADMS-Urban/ADMS-Roads interface.
The ‘#1° parameter can be used with the Average speed fields and/or Percent
uphill fields box to indicate a constant value. The constant value itself
should be entered into the Vehicle speed factor/Percent uphill factor box. The
‘#50° parameter is there as a convenience for use with the Percent uphill
fields box (50% implies flat-road emission factors will be used throughout).
The Vehicle count factor, Vehicle speed factor and Percent uphill factor boxes
can be used to apply any appropriate conversions to the data in the current
layer. For example, vehicle speeds should be given in km/hr in the ADMS-
Urban/ADMS-Roads interface, so if the vehicle speed data in the current
layer are in mph, a value of 1.61 should be specified in the Vehicle speed
factor box.

Press Export to bring up a Save As window. Browse to where you want the
files to be saved, give them a name (common stem), then click on the Save
button. This will generate up to four files: an .spt file (containing source
properties), a .vgt file (vertex information), an .eit file (pollutant
emissions) and a .tft file (traffic flows).

(optional) These files can then be modified further in a text editor (e.g.
Notepad) or spreadsheet package (e.g. Microsoft Excel), if required, before
being imported into the ADMS model via the File > Import menu item from
the model interface; see the relevant model user guide for full details on
importing sources from .spt files.

(optional) Once the sources have been imported into the model interface
and the Mapper has been refreshed, it may be desirable to remove/untick
the original non-ADMS layer to avoid duplicating the visualisation of
these sources.
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6.3 Clip layer to polygons

The Clip layer to polygons tool allows individual features from one layer to be ‘clipped’ to
the features from a separate layer, i.e. retained/removed depending on whether they fall
inside or outside the spatial boundaries of the second set of features. The resulting set of
clipped features are saved to a new shape file rather than replacing the original layer. If
clipping zero-dimensional features, e.g. output points, there is also an option to save the
clipped data to an .asp file, which can then be used in an ADMS model run. It is
possible to clip onto any layer that contains polygons or polylines.

6.3.1 Clipping point, polyline or polygon layers

Step 1 Right-click on the layer that you wish to clip, e.g. the Line sources layer, and
select Clip layer to polygons. This brings up the Clip from: form, as shown in
Figure 68.

?\, Clip from: Buildings *

Clip to:

Clipping options

* Whaolly inside

™ Imside including partly outside
" wWhally outside

" Outside including partly inside

Dutput options
* Create shape file
r

Mame: | I ame J

Z |Elevation J

Ok, | Cancel |

Figure 68 - Clip layer to polygons

Step2  Select which layer to clip to using the drop-down menu.

Step 3 Select from one of the following Clipping options:

Wholly inside: Any feature that falls completely inside one of the features
being clipped to will be retained.

Inside including partly outside: Any feature that falls at least partly inside
one of the features being clipped to will be retained. This option is not
available if clipping zero-dimensional features, e.g. point or jet sources.

Wholly outside: Any feature that falls completely outside all of the features
being clipped to will be retained.

Outside including partly inside: Any feature that falls at least partly outside
one of the features (and not wholly inside any of the features) being
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Step 4

Step 5

clipped to will be retained. This option is not available if clipping zero-
dimensional features, e.g. point or jet sources.

The Count in the Clip to: section shows how many features will be retained
with the current clipping option. The map view window will also interactively
show which features will be retained as different clipping options are
selected.

In the Output options section, select how the clipped features should be saved
by choosing either Create shape file or (if clipping zero-dimensional features)
Create ASP file. For the latter option, you should also use the Name and Z drop-
down menus to specify which of the fields in the layer being clipped contain
the specified point names and heights, respectively.

Press OK to create the output file. If Create shape file was selected, the resulting
shape file will automatically be added as a new layer in the Mapper, and the
original layer being clipped will be unticked.

6.3.2 Clipping raster layers

Step 1

Step 2
Step 3

Right-click on the raster layer, i.e. the contour plot, that you wish to clip and
select Clip layer to polygons. This brings up the Clip from form, as shown in
Figure 69.

?\, Clip from: Examplel *

Clip to:

Clipping options
* Whaolly inside
~

" wWhally outside
r

Dutput options
* Create GRD file
~

Marme: | J
Z | J

Ok, | Cancel |

Figure 69 - Clip layer to polygons

Select which layer to clip to using the drop-down menu.
Select from one of the following clipping options:
Wholly inside: Data inside all of the features being clipped to will be retained.

Wholly outside: Data that falls completely outside all of the features being
clipped to will be retained.

The map view window will interactively show the resulting layer as different
clipping options are selected.
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Step 4  Create GRD file is selected in the Output options section as clipped raster layers
can only be saved as *.grd files. Press OK to create the output file. The
resulting file will automatically be added as a new layer in the Mapper, and
the original layer being clipped will be unticked.
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6.4 Create Street Canyon and Urban Canopy files

The Canyon and Canopy tool creates *.csv format parameter files that can be used directly
with the Advanced Street Canyon and Urban Canopy Flow modules in ADMS-Urban.
The tool outputs all of the required headers together with the following Street Canyon
parameters for each feature in the roads layer:

e Canyon heights (maximum, mean and minimum)

e Canyon widths

e Canyon lengths
And the following Urban Canopy parameters which characterise an urban area as
defined on a rectangular grid:

e Average building heights

e Average canyon widths

e LambdaP (1p) values, a measure of building coverage at ground level

e LambdaF (4r) values, a measure of building fascias for multiple directions

6.4.1 Using the Canyon and canopy tool

The Canyon and Canopy tool generates the parameter files using a buildings layer and a
roads layer that have been added to the Mapper. To use the tool:

Step1  Select the Canyon and Canopy option from the Tools menu to bring up the
Canyon and canopy tool screen. Ensure that ADMS is set to a valid coordinate
system as the tool uses the coordinate system in the ADMS interface.
Otherwise, the menu option will not be available. If the map coordinate
system is different from the ADMS coordinate system, a notification dialog
will inform you that the map will be set to the system currently used in the
ADMS interface.
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Step 2

@ Canycn and canopy tool

Input
[v Buildings: only show active layers [v Roads: only show active layers
Buildings
“Y'ou must pre-process the buildings to remove inelevant objects before running any calculations

2

Roads
Roads are required for the street canyon calculation, but are optional for the canopy calculation

=l 3|

| Road sources

Dutput
Coordinate spstem; 0SGB3E British Mational Grid [epsg: 27700)

Street canpon

=l 3|

=1 o
3l
i

Road name figld M ame J Foad width field “fidth
Urban canopy
Grid definition ‘Wind sector boundaries
Minimurn [m]  kasimum [m) Cell size [m) 0 - | &
) - | -]
1000 1000 1000 180 ,7
T 1000 1000/ 1000 J J
0 v
9 [width =]
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Figure 70 - Canyon and canopy tool screen

The Canopy Output Cells and Extent are now displayed in the map as new

layers. Initially, the extent covers the whole of the current map view window.
The generated cells will be used in the Urban Canopy calculations, see 6.4.4.

B Mapper

Project Edit View Layer Jools Settings Help

8% 2T ®|Ra9 40 @&Es (m-~ ZL
Layers Grouping 3D

- O X

= [ Canopy Output Cells [4)

B ¥ Canapy Output Extent
B[V Point sources (0]
[ ]
B [¢ Line sources (1)
7/
B [+ Road sources 0]
B[V Area souces (0]
B [v Volume sources (0]
A
B [v Grid source cells [0)

E [V Output grid extent

B [v Output grid points [967)
+

Map: OSGE36E British Mational Grid [epsg:27700]

13821 ¥: 73.06 | Editing: none

400 m

Scale: 1:15,300

Figure 71 - Canopy Output Cells and Extent layers in the Mapper as red rectangles
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Step3  You must pre-process the buildings data before any calculations can be
carried out. Select the layer you wish to process and the name of the building
height field from the Buildings drop-down menus. Configure the processing
options if necessary, see Section 6.4.5 for a description of the available
options. If the buildings data have already been pre-processed, skip to Step 5.

Some data sources define buildings data across multiple sets of *.shp files.
The Shape file merging tool can be used to combine such data into a single file.
See Section 6.5 for details about the tool.

Only polyline or polygon layers displayed in the Mapper are included in the
drop-down menu. Uncheck the Buildings: only show active layers checkbox to
also include hidden layers.

step4  When you have confirmed all the settings are as you desire, click the »
button to start the pre-processing. You will be prompted to enter the name of
the output file. Once the file has been successfully created, it will be
automatically added to the map as a new layer and selected in the Buildings
layer drop-down menu.

Step 5  Select the roads data layer that you wish to use in the calculations from the
Roads drop-down menu.

It is possible to use the roads data defined in the ADMS model by selecting
the Road sources layer. On the other hand, using roads data is not required in
Urban Canopy calculations. If so, select [No road layers].

Only polyline or polygon layers displayed in the Mapper are included in the
drop-down menu. Uncheck the Roads: only show active layers checkbox to also
include hidden layers.

Step 6  If generating Street Canyon files, continue to Step 7. Otherwise if generating
Urban Canopy files, skip to 0.

If generating Urban Canopy files and the selected roads data layer is not
defined with canyon widths, you need to generate the Street Canyon files first.
Select the advanced setting Create canyon shape file and then use the additional
output *.shp file as roads data for Urban Canopy.

Step 7 Select the Road name field from the drop-down menu to be written to the
output *.csv file. Select the Road width field to use in the canyon width checks
if it is defined in the roads data layer. Otherwise, select [No width defined].
Configure the settings for the street canyon calculations if necessary, see
Section 6.4.5 for a description of the available options.

Step 8  When you have confirmed all the settings are as you desire, click the »
button in the Street canyon section to create the output file(s). You will be
prompted to enter the name of the output file. If the advanced setting Create
canyon shape file is selected, the additional output *.shp files will be created in
the same directory with the same file stem. Once the files have been
successfully created, the Canyon and canopy tool screen will close.
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Step 9  Define the output grid and cell size, shown as the Canopy Output layers in the
map and is set to the current map view window by default. If you wish to
change the extent, you can redefine, move or edit it using the standard
Mapper editing tools (see Figure 71). You can hide the layers in the map
view by clicking on the = button. Alternatively, you can edit the extent
manually in the Grid definition section.

Step 10  Specify the Wind sector boundaries for the LambdaF calculations. The pre-set
boundaries cover the sectors 0 to 90 degrees, 90 to 180 degrees, 180 to 270
degrees and 270 to 0 degrees. The following actions are available if you wish
to change the list of wind sector boundaries:

e Add a sector boundary by typing the angle in degrees (from 0 to 359) in
the text box and then clicking on the Plus button.

e Remove the selected item on the list by clicking on the Minus button.

e Generate the set of boundaries for uniformly sized sectors by clicking on
the Edit button. In the Create sectors sub-screen, select whether specifying
a starting angle for Wind sector boundaries or Wind directions and then type
the Start angle and Number of sectors. The panels show the resulting wind
sector boundaries and corresponding wind directions. Update the list in
the Canyon and canopy tool screen by clicking OK.

B Create sectors ¥
Define Create
. . Boundaries Directions
{* Wind sector boundaries
0.00 - 50.00 45.00
" wind directions 50.00 - 130.00 135.00
180.00 - 270.00 22500
St o 270.00-  0.00 315.00

Mumber ,74

e Cancel

Figure 72 - Create wind sectors

e Check the wind directions for which LambdaF will be calculated by
clicking on the Information button 0.

Wind directions *

0 The following wind directions are defined:
L J 45
= 135

225

315

Figure 73 - Wind directions for the pre-set sectors

e Set the wind sector boundaries to default by clicking on the Reset button.

Step 11  Select the canyon width fields from the drop-down box(es), which could
either be the Total canyon width or Left and right canyon widths.
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step 12 When you have confirmed all the settings are as you desire, click the »
button in the Urban canopy section to create the output file(s). You will be
prompted to enter the name of the output file. If the advanced setting Create
canopy shape file is selected, the additional output *.shp files will be in the
same file stem. Once the files have been successfully created, the Canyon and
canopy tool screen will close.

6.4.2 Pre-processing buildings

The buildings layer needs to be prepared before any calculations can be carried out by
the tool. The pre-processing cleans up the buildings layer by removing all features that
are smaller than the minimum height set in the Advanced settings, takes applicable
actions to overlapping features and exports the resulting layer to new ESRI shape files
(*.shp) with the following new fields added:

e Tower height field: Height (m) of the part of an enclosed building that is above a
shorter enclosing building (see example below).

e Intersecting building field: True if a building intersects with another building.

The removed building features are stored in additional set of shape files with the same
file stem as the processed files affixed with * X’ e.g. Output_X.shp.

The buildings layer is analysed and searched for intersecting features as these may
affect the main calculations carried out by the tool. Two or more buildings found in
the same location generally represent a single building rendered into multiple parts.
Figure 74 shows a building feature enclosing another building of larger height. In this
example, the Tower height field for the taller building will be assigned as the difference
between height a and height b while for the shorter building, zero.

length a

length b

S ——_—

height a

P

vl ]| heignt b
"""" SIS road feature

Building face

Figure 74 - lllustration of the approach taken with enclosed buildings

The Tower height field is only used in the calculations for the urban canopy parameter
LambdaF, which requires the cross-wind vertical area of buildings shown in Figure 74
as the building face with respect to the perpendicular wind.

If the enclosed building is smaller in height, it is therefore fully contained inside the
larger building. Fully contained features are removed from the buildings layer during
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pre-processing as they have no impact to the calculations.

Alternately, although less common, a building feature may not be enclosed by the
intersecting building(s). In such cases, the tool assumes that every feature is separate.
Each building is assessed and the common feature is assigned to the larger building
and subtracted from the smaller building(s).

Figure 75 shows a variation of the previous example where building a is not enclosed
by building b. In this example, building a will retain its geometry as it is the taller
building while the intersecting part will be clipped from building b.

F*r.

L P
L L T
LRI

[

o, 3, L
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Figure 75 - Intersecting buildings without enclosing

6.4.3 Creating Street Canyon files

The Canyon and canopy tool generates perpendicular lines from the road centreline
extending outward at equal intervals along the road to “search” or identify all building
features that may affect the road. The length of the lines is the maximum distance from
the road centreline that the tool will search buildings. The length of perpendicular lines
and other settings for carrying out searches can be altered by the user in the Advanced
settings (see Section 6.4.5).

The canyons are identified by the name of the corresponding road source. The left and
right sides of the canyon are assigned according to the orientation of the first and
second vertices, where the first vertex represents the start and the second vertex
represents the end of the first straight-line segment of the road. The left and right side
calculations are carried out independently.

For each road and each side of the road, the tool:

e Creates lines from the road centreline perpendicular to the road with a length
equal to the Maximum canyon width (m) used to search for buildings that interact
with the line. The first perpendicular line will be located at half the Search
spacing (m) distance from the first road vertex. The succeeding lines are created
every Search spacing (m) until the entire road is covered as in Figure 76 for one
side of the road. Each line will be assigned with a canyon width and height
value to represent that portion of the road.
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@Mapper
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Figure 76 - Perpendicular lines generated on one side of the road

e Evaluates all interacting buildings to determine the values to assign each line.
The canyon width is the distance from road centreline to the nearest interacting
building. Only buildings above the Gradient (height-to-width) setting are evaluated
to avoid including small structures that do not affect the road in a meaningful
way. In the example in Figure 77, building a falls below the gradient and thus is
not considered an interacting building.

Figure 77 - The gradient setting used in evaluating which buildings to include

e Selects the building to take the canyon height from based on a dynamic,
adaptive gradient. This gradient is adjusted according to the buildings included
with the Gradient (height-to-width) setting. Buildings are included in the selection
if their height is at or above the adaptive gradient, shown as red dashed lines in
Figure 78. As aresult, a building can still be excluded in the selection if it falls
below the adaptive gradient. The canyon height is the height of the most
significant building or the building with the largest gradient. Included buildings
are numbered according to how far they are from the road, 1 being the nearest
and so on. The selection limit is determined by the Building search limit setting,
with a value of 0 being no limit. In the example, the height of building 2 is used.
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Figure 78 - The gradient setting used in evaluating which buildings to include

e Calculates the median and average of all the canyon width values assigned to
each perpendicular line. Each canyon width is then compared against both the
median and average. A tolerance for the comparison is set by multiplying the
median and average by the Quality tolerance factor. The quality is determined by
the number of individual width values, i.e. number of perpendicular lines the
widths are assigned to, that fall within this tolerance. The tool selects the
resulting width for the road between the median and average based on which
has the higher quality.

In addition, the tool checks if the resulting canyon overlaps with the road
carriageway by checking the canyon width against the road half-width.

e Calculates the average, minimum and maximum values of canyon heights
assigned to each perpendicular line. Similarly, the quality of the average height
is determined by the number of individual height values that fall within the
tolerance calculated by multiplying the average by the Quality tolerance factor.
However, the median value is not calculated and the quality is only used to
indicate the reliability of the average height.

e Calculates the length of the road with adjacent buildings as the number of
perpendicular lines with interacting buildings multiplied by the spacing.

The following limitations apply:
e A road with no adjacent buildings will be assigned values of 0 for all of the
Advanced Canyon parameters.

e Buildings that touch or cross the road centreline are ignored for that road
segment.

e Buildings must be above the Minimum building height (m) and Minimum building
footprint (m?) requirement to be included in the calculation for any road segment.

e The parameter fraction of canyon area covered by overhanging features is not
calculated by the tool and will be set to 0.
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The parameters output by the Canyon and canopy tool are described in Table 5 below.
Parameters unique to the output shape file are described in Table 6.

Variable name Variable name | Units | Description

in *.csv file in shape file

Name B - Source (road) name

X1, ¥l - m x and y coordinates of first vertex (start)

X2, Y2 - m x and y coordinates of second vertex (end of
first segment)

width Nt c_width n? m Distance from road centreline to canyon wall

avgHeight N c_height n | Average canyon height

minHeight N c_h_min_n m Minimum canyon height

maxHeight N c_h_max_n m Maximum canyon height

buildlength N | c_b_len n m Length of buildings in canyon

fracCovered B - Fraction of canyon area covered by
overhanging features (always zero)

Table 5 - Advanced Canyon parameters. 'Refers to variables for the left (L) and right (R) sides
of the canyon. 2Likewise but in lower case.
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Variable name | Units | Description

c_widthtot —|m Total distance between canyon walls on left and right sides; sum of
c width landc width r

c_length n m Length of canyon including gaps between buildings

c_start_n m Distance from start of road to first building in canyon

c_w aven m Average canyon width

c_w_aveq n - Quality of calculated canyon widths against the average value
expressed as percentage of perpendicular lines per road source

c_w_med n m Median canyon width

c_w_medq_n - Quality of calculated canyon widths against the median value
expressed as percentage of perpendicular lines per road source

c_w_aorm_n - Indicates if the more accurate value of canyon width is the average
(“A”), median (“M”) or they are equally accurate (“E”); comparison
of c w aveq nandc w medg n

c_wW_ok_n - Blank if the canyon wall is outside or does not overlap with the
road carriageway; otherwise, assigned with “x”

c_w_stdv_n m Standard deviation of canyon width values

c_h_qlty n - Quality of calculated canyon heights against the average value
expressed as percentage of perpendicular lines per road source

c_b_por_n - Amount of perpendicular lines not representing a canyon expressed
as percentage per road source

c_b_pnmx_n - Amount of successive perpendicular lines not representing a
canyon expressed as percentage per road source

c_b_plmx n | m Longest length of the road that is not a canyon

c b srch n

Degree of how close to the road the buildings from which the
canyon height was taken are, expressed as the average of the
building number for each perpendicular line

Table 6 - Advanced Canyon parameters in the output shape file
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6.4.4 Creating Urban Canopy files

The Canyon and canopy tool first defines the grid layout of the urban canopy data. The
limiting coordinates of the user-specified Grid definition are rounded to start at a
suitable coordinate divisible by the Cell size (m). The rectangular grid is defined starting
from the south-west corner extending eastward and northward by the cell size covering
the entire buildings layer and, if applicable, roads layer. Each of the urban canopy
parameters is then calculated for each cell.

For the coordinates of a point in the cell, the cell centre is used.

The average height of buildings in the cell is weighted by plan area. Buildings
with a larger footprint will have a larger influence on the calculated average.

If there are buildings present in the cell, the average canyon width is calculated
for all canyon widths within the cell weighted by the length of each road. If
there are no roads present in the cell or the user has selected [No road layer] from
the Roads drop-down menu, the Default canyon width (m) is used.

The urban canopy canyon widths provide the width from the road centreline to
the buildings on each side of the road, not the width of the carriageway itself.

LambdaP is calculated as the ratio of the horizontal area taken up by buildings
or the building footprint within the cell to the total area of the cell.

LambdaF is calculated as the ratio of the cross-wind vertical area of buildings
to the total area of the cell, for each of the Wind sector boundaries provided by
the user. The Wind directions used are the centre angles of each wind sector. For
each direction, the vertical area of the building is calculated from the product
of the cross-wind extent of the building and its height.

When two or more buildings of varying height occur in the same location, the
height and length of each part of the buildings is apportioned into multiple
segments. This is illustrated in Figure 74. The tower height (see Section 6.4.2)
is used to calculate the area of the building face for building a.

Adjoining (touching) buildings are counted separately, not merged. The tool
does not treat internal building faces, it only takes into account the widest
points of a building perpendicular to the wind direction.

The parameters output by the Canyon and canopy tool are described in Table 7 below.

Variable name Variable name Units | Description

in *.csv file in shape file

XX X, X m x and y coordinates of cell centre

H H m Average building height

G CanWidth m Average canyon width

LambdaP LambdaP _ LambdaP value

LambdaF LF_<angle - LambdaF values for binned wind sectors
<angle range> | range>

Table 7 - Urban Canopy parameters
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6.4.5

Advanced settings

Table 8 shows the available settings that the user can configure.

Setting Description
Processing | Canyon Minimum building | Minimum height of buildings to include in the
buildings height (m) street canyon calculations.

Minimum building | Minimum plan area of buildings to include in

footprint (m?) the street canyon calculations.

Canopy Minimum building | Minimum height of buildings to include in the
height (m) urban canopy calculations.!

Processed | Tower height field | Field name to use in the processed *.shp file for

file field the tower height.

hames Intersecting Field name to use in the processed *.shp file for
building field the intersecting building indicator.

Canyons Search Maximum canyon | Distance from the road centreline the tool will

width (m) search to find interacting buildings.

Gradient (height- | Ratio of the height of building features on the

to-width) side of the road and its distance to the road
centreline, above which the building will be
considered a canyon.

Search spacing Distance between the generated perpendicular

(m) lines.

Building search Number of buildings to include in the selection

limit for the canyon height based on an adaptive
gradient.

Quality Canyon width Multiplier for the calculated median and

tolerance average canyon width. The resultant is used as

factor tolerance for checking the accuracy of
individual canyon widths.

Canyon height Multiplier for the calculated average canyon
height. The resultant is used as tolerance for
checking the accuracy of individual canyon
heights.

Canopy Roads Default canyon Value to use as average canyon width if no road
width (m) features occur in a cell.
Output Additional | Create canyon Whether to create additional *.shp file with
output shape file street canyon parameters.

Create canopy Whether to create additional *.shp file with

shape file urban canopy parameters.

Ccsv Data delimiter Delimiter to use in the output *.csv file.
output

Table 8 - Advanced settings

1. Building features that are below the smaller height value are removed from the
layer during pre-processing.
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6.5 Merge shapefiles

The Shape file merging tool allows the user to merge multiple *.shp files and select which
fields from those files to include in the merged output. The tool can also be used for
renaming fields in the output file.

@ Shape file merging tool *
Input files
Examplel.zhp +
Example2.shp
Select fields
Excluded: 3 Included: 2
Mame Type File | -~ M ame Type ~
varBool Boolean  Examplel.shp warlnt Integer
varll ate Date Example? shp warstr String
varReal Real Examplel.shp, Example? shp 2%
El
=
<4
] v
Cancel

Figure 79 - Shape file merging tool

Files for merging are generally expected to have similar field structures. In cases where
the field structure is not consistent across input files, mismatched fields are dealt as
follows:

o If a field selected for the merged output is not defined in an input file, the tool sets
it to a default value configurable by the user (see Section 6.5.2).

e If fields of the same name are defined as different data types in the input files, the
tool allows the user to select which data type from a corresponding file to take (see
Section 6.5.3).

The following limitations apply:

e Files cannot be empty i.e. must contain at least one feature.
e Files must be of the same coordinate system, shape type and dimension type.
e The shape file format only allows a maximum of 255 fields.

e Field names in the shape file format cannot be longer than 10 characters. The tool
uses an aliasing system to allow for longer field names. However, the field names
in aliased files may not be displayed correctly if viewed using other software.

e The maximum length of string type fields in the shape file format is 254. Also, float
type fields are stored with 15 (positive values) and 14 (negative values) significant
figures.
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6.5.1 Using the Shape file merging tool

Select the Merge SHP files option from the Tools menu to bring up the Shape file

Step 1
merging tool screen.
Step2  Add the input shape files by clicking on the Plus button. The Open Shape File
screen is then displayed.
B Open Shape File *
« v # ThisPC » Local Disk (D:) » Example v @ Search Example pel
Organise * Mew folder =~ [ @
MName - Date modified Type Size
7 Quick access
Mo items match your search,
@ OneDrive - Personal
> [0 This PC
¥ Network
File name: v| ArcView Shape Files (*.shp) ~
Cancel
Figure 80 - Open Shape File
Step 3 Browse to find the *.shp files to be merged then click on the Open button. The

selected files will be added to the Input files list. The fields found in the files

are automatically added to the Excluded list, showing the Name of the field, its
Type and the File(s) it is found in. Remove a file from the list by selecting it

and clicking the Minus button.

I Shape file merging tool x
Input files
Select fields
Excluded: 3 Included: O
N arne | Type | File |A Narne | Type | ~
varB ool Boolean  Examplel.shp
varReal Real Examplel.shp
warsie Sting Examplel.shp ﬂ
>
] ]
(] 4 | Cancel |

Figure 81 - Fields are added to the Excluded list upon loading input files

Mapper User Guide

Page 108



SECTION 6 — Tools

As an alternative to Steps 2-3, file(s) can be drag-dropped from Explorer
onto the Input files list.

Step 4

Step 5

6.5.2 Editing
Step 1

Step 2

Step 3

Step 4

Select the fields to be included in the output file by using the arrow buttons
between the Excluded and Included lists.

e Move all fields by clicking on the >> or << button.
e Move one or more selected fields by clicking on the > or < button.

When you have confirmed that all the necessary fields to include in the output
file have been selected, click OK to proceed with the merge. You will be
prompted to enter the name of the output file. Once the file has been created,
the Shape file merging tool screen will close.

field names and default values

Open the Shape file merging tool screen and add the files to be merged. The
fields found in the files will be added to the Excluded list.

Select the fields to be included in the output file by using the arrow buttons
between the Excluded and Included lists.

Edit a field in the Included list by double-clicking on it. The Edit field screen is
then displayed where the following actions are available:

e Specify the new field name on the first textbox to rename it.

e Specify the default value on the second textbox to set the field to if it is
not found in one or more files. This is necessary as shape files cannot
contain null values.

For specifying the default value of Boolean-type fields, a checkbox is used
rather than a textbox; for date-type fields, a date selector is used.

e Navigate to other items, if any, in the Included list by clicking on the arrow
buttons.

B Edit field X

varlnt - Integer Lol

|inwar| 0

aE.

Figure 82 - Edit field screen

Once you are satisfied with your edits, click the OK button. The Included list
will be updated to use the new names.
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@ Shape file merging tool X
Input files
Examplel.shp +
Example2. shp
Select hields
Excluded: 3 Included: 2
[ame Type Filz | ~
warB ool Boolean  Examplel.shp ! =
warllate Date Example2.shp warStr Shing
warFeal Real Examplel.shp, Example? shp %
B
=
{4
v v
ak. | Cancel

Figure 83 - Updated field name after editing

6.5.3 Resolving field type conflicts

Fields defined in multiple files as different data types are marked as Conflict under the
Type column of the Excluded list. Fields marked as conflict must be resolved before
they can be added to the Included list.

Step 1 Open the Shape file merging tool screen and add the files to be merged. The
fields found in the files will be added to the Excluded list.

B Shape file merging tool X
Input files

Examplel.shp j
=

Exarple2 shp

Select hields
Excluded: 5 Included: O

Iame Type File | ~ MHame Type -
warB ool Conflict  Examplel.shp, ExampleZ. shp
varD ate Conflict — Ewamplel.shp, Exampled shp
Examplel.shp, Examples. shp

>
warFeal Conflict  Examplel.shp, ExampleZ. shp
>

warste Sting Examplel.shp, Example? shp

ak. | Cancel |

Figure 84 - Fields defined as varying types are marked as Conflict
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Step 2 Resolve a Conflict field by double-clicking on it. The Resolve conflict screen is
then displayed where the following actions are available:
e Select the checkbox next to the Type to derive the data type from the input
File the field is defined in.
e Navigate to other items, if any, in the Excluded list by clicking on the
arrow buttons.
@ Resolve conflict g
warlnt jﬂ
.................................
Integer Examplel.zhp
[[1 String Example?. shp
] | Cancel |
Figure 85 - Resolve conflict screen
Step 3 Once you have ensured all necessary fields have been resolved, click the OK

button. The Excluded list will be updated with the selected data types. Fields
that have been resolved can now be moved to the Included list.

I Shape file merging tool X
Input files
Examplel.shp +
Examplez. shp J
Select fields
Excluded: & Included: O
M arne | Type | File |A Narne | Type | ~
warB ool Conflict  Examplel.shp, Example2. shp
varliate Conflict  Examplel.shp, Example2. shp
Example].shp. Examples. shp ﬂ
varReal Conflict  Examplel.shp, Example2. shp
warst Sting Examplel.shp, Example2. shp j
] ]
(] 4 | Cancel

Figure 86 - Updated type after resolving conflict

When copying the field values of differing data types, simple conversion is done for
compatible data types. Otherwise, incompatible types are set to default values (see
Section 6.5.2). Some examples of acceptable conversion between dissimilar types are:

e Numerical string to float or integer

e Integer to Boolean: “1” = True; any other value = False
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e String to Boolean: “true” or “ves” = True; any other string = False
e Date to string, and vice-versa: Follows the system regional settings

e Any type to string
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A.1 Label formatting

This section? outlines how to format the display labels using some of the more advanced
features available in the Mapper.

A.1.1 Overview

The Mapper provides a simple markup language for custom label formatting. You can
apply this in the Label section of the layer properties dialog for the layer.

Vector: Road sources (8) x
+ = X v a Visible
General Value (o
Sections
B Section 1 j
Renderer
Marker I+ b r
Line
Area Font
Chart
3D |“*||E|I J apt J ‘. Q00000 J
B Section 2
I u [+
I I
Label
|. FFFFO0 J | J ‘ J
| 2500 twips | |2500 twips R |
Cutline
=a= | | (e [ T | v

Wizard ... OK | Cancel | Apply ‘

Figure 87 - Layer label properties

You can use the Value to both define and format the label using format descriptors
described in the rest of this section. The label can be any combination of fixed text and
fields defined in the current layer. A simple example would be to have the fixed text
“Canyon” and then use the CanyonHeight field to display the canyon height for all
roads using the specified formatting.

2 This information is taken from the following site:
https://docs.tatukgis.com/EDT/ENU/Help/index.htm?mnulayerpropertiesvectorlabelformatting.htm
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+ —

General

Sections

B Section 1
Renderer
Marker
Line
Area
Label
Chart
30

B Section 2

Lorem
ipsum daolor

&= B

Wizard ... |

Vector: Road sources (8)

¥ oW A

Visible

Value

ICanyon <B»{CanyonHeight}</B=| j

v Visible v Avoid overlap [~ Avoid duplicates
Eont

Mame Size Colar

| arial R4 EES = I. 000000 j

[~ Bold [~ Underline v Shadow

[T Italic [~ Strikeout
Label

Calor Pattern Shield

||:| FFFFO0 j I Transparent j I Clear j

Width Height Smart size

|2500 twips | |2500 twips | | 1px |
Qutline

Style Color Pattern

I - [ | ITm————— |

oK I Cancel Apply

Figure 88 - Setting the label value option

@Mapper
Project Edit View Layer JTools

Settings

Help

%PEFIRBTIERRAQAGO e+ Bas OB OC|EBE (RS-

Layers Grouping an

Bl [ Point sources 1)

B [ Line sources [0

B v Area sources [0]

A
B [v Yolume sources (0]
A
B [v Grid source cells (0]
B [v Output grid extent

B [+ Output grid points [961]
+

e

ADMS-iban |

200 m

Il ap: O5GE3E British Mational Grid [epsg: 27700]

‘ 54471561 : 259263.55 | Editing: none

Figure 89 - Map with formatted labels
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A.1.2 Visual formatting

The Value input supports some of the standard HTML markers for visual formatting:

Markup Description

<B></B> Text inside is displayed in bold

<I></I> Text inside is displayed in italic

<U></U> Text inside is underlined

<HR> Horizontal line

<BR> Line break

<P></P> Text inside is treated as a complete paragraph
<STRONG></STRONG>

Text inside is displayed in extra bold font

<FONT SIZE="S"
NAME="F"
COLOR="C"></FONT>

Text inside is displayed in the F font of the size S and colour C

F: ARIAL, TIMES, TAHOMA, etc.

C: BLACK, BLUE, FUCHSIA, GRAY, GREEEN, LIME, MAROON,
NAVY, OLIVE, PURPLE, RED, SILVER, TEAL, WHITE, YELLOW
The C colour can be also given in the RGB representation #RRGGBB,
where RR, GG and BB are two digit hexadecimal number
representations of the red, green and blue colour intensities

&amp; The ampersand (&) sign
&nbsp; Forced insertion of space
&gt; The greater-than (>) sign
&lt; The less-than (<) sign
Table 9 - Simple markup
Example

<U><FONT NAME="ARIAL" COLOR=#FF0000><I>valuel</I></FONT>&nbsp;<FONT
NAME="ARIAL" COLOR=#0000FF><B>&1t;</B></FONT>&nbsp; <FONT NAME="ARIAL"
COLOR=#00FF00><BOL>value2</BOL></FONT></U>

The above code will result in the following label: valuel <

A.1.3 Inserting fields

The code {FIELD_NAME:FORMAT} inserts the value of a field or attribute
named FIELD_NAME with formatting defined by the format string FORMAT. The format
string is attribute type specific.
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A.1.4 Formatting of NUMBER and FLOAT type attributes

Automatic formatting:

Format ——
Format name | Description

character

Corec Currency Integer following the character defines the number of digits
displayed after the decimal point (default is 2).

Uses the currency marker from the system settings.
Dor d Digit Integer next to the character defines the minimum number of digits
(integer) to be displayed; number will be padded with zeroes if necessary;
non-integer value will be rounded first.

B ore Scientific Integer next to the character defines the number of digits displayed

(exponential) | after the decimal point (default is 2); number formatted
as Scientific is always displayed in exponential form;

Foor f Fixed-point Integer next to the character defines the number of digits displayed
after the decimal point (default is 2).

Gorg General Displays the number in a format best suited for the value; Integer
next to the character defines the number of significant digits.

N or n Number Integer following the character defines the number of digits
displayed after the decimal point (default is 2); inserts thousand
separators accordingly to the system settings.

Porp Percent The number is multiplied by 100; Integer following the character
defines the number of digits displayed after the decimal point
(default is 2)

Ror r Round-trip Equivalent of General; Integer next to the character is ignored.

X or x Hexadecimal | Integer next to the character defines the minimum number of

hexadecimal digits to be displayed; number will be padded with
zeroes if necessary; non-integer values will be rounded first.

Custom formatting:

Table 10 - Automatic number formatting

Format Name Description

character

# Digit Defines optional position of a digit; if corresponding digit in the
placeholder value does not exist, the digit placeholder is neglected.

0 Zero Defines obligatory position of a digit; if corresponding digit in the
placeholder value does not exist, the zero placeholder is replaced by ‘0".
Decimal Defines the position of the decimal point.
point

[other]

Other characters are displayed without any change.

Table 11 - Custom number formatting
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Examples:
Code Attribute | Result Note

value string
{FIELD NAME:#.###} 123.59 '123.59'
{FIELD NAME:#.000} 123.59 '123.590'
{FIELD NAME:#.####0} 123.59 '123.59000'
{FIELD NAME:##### . ##4) -123.59 '-123.59'
{FIELD NAME:00000.###} 123.59 '00123.59'
{FIELD_NAME:0-0-0-0-0} 123.59 '0-0-1-2-4' | rounding
{FIELD_NAME:over f#;below #;zero #} | 19359 'over 124" rounding
{FIELD_NAME:over #;below #;zero #} | _12359 ‘below 124" | rounding, no minus

sign

{FIELD NAME:over #;below #;zero #} 0 'zero ' no zero sign
{FIELD_NAME:over #;below #;zero 0} | 'zero 0'
{FIELD NAME:;below #;zero#} 123.59 " empty string
{FIELD NAME:over #;;zero#} -123.59 " empty string
{FIELD NAME:over #;below #;} 0 " empty string

Table 12 - Number formatting examples

A.1.5 Formatting of BOOLEAN type attributes

Automatic formatting:

Code Attribute value Result
{FIELD NAME} True True'
{FIELD_NAME} False 'False'

Table 13 - Automatic Boolean formatting

Examples:

Code Attribute value Result Note
{FIELD NAME:yes;no} True ‘yes'

{FIELD NAME:yes;no} False no'

{FIELD NAME:yes} True yes-

{FIELD NAME:yes} False " empty string
{FIELD_NAME:;no} True " empty string
{FIELD NAME:yes; } False " empty string
{FIELD NAME:yes;nol;no2} False 'nol:no2"

Table 14 - Boolean formatting examples
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A.1.6 Formatting of DATE type attributes

Note: character in brackets represents a string consisting of any number of this character.

Format Format name Description

string

d Day Day as a number 1 to 31

dd Day Day as a number 01 to 31

ddd Day Day as an abbreviated name of the day of the week; depends
on system regional settings

dddd (d) Day Day as a full name of the day of the week; depends on
system regional settings

£ Second fraction Most significant digit of the second fraction

£t Second fraction Two most significant digits of the second fraction

£ff Second fraction Three most significant digits of the second fraction

free Second fraction Four most significant digits of the second fraction

I Second fraction Five most significant digits of the second fraction

frefff Second fraction Six most significant digits of the second fraction

FELLLLE(E) | Second fraction Seven most significant digits of the second fraction

F Second fraction Most significant digit of the second fraction; if zero then
nothing will be displayed

FE Second fraction Two most significant digits of the second fraction; trailing
zeros will be truncated

FEE Second fraction Three most significant digits of the second fraction; trailing
zeros will be truncated

FEFE Second fraction Four most significant digits of the second fraction; trailing
zeros will be truncated

FEFEE Second fraction Five most significant digits of the second fraction; trailing
zeros will be truncated

FEFFEF Second fraction Six most significant digits of the second fraction; trailing
zeros will be truncated

FFFFFF (F) | Second fraction Seven most significant digits of the second fraction; trailing
zeros will be truncated

h Hour Hour as a number 1 to 12

hh (h) Hour Hour as a number 01 to 12

H Hour Hour as a number 1 to 24

HH (H) Hour Hour as a number 01 to 24

m Minute Minute as a number 0 to 59

mm (m) Minute Minute as a number 00 to 59

M Month Month as a number 1 to 12

MM Month Month as a number 01 to 12

MMM Month Month as an abbreviated name of the month; depends on
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system regional settings

MMMM (M) Month Month as a full name of the month; depends on system
regional settings

S Seconds Seconds as a number 0 to 59

ss(s) Seconds Seconds as a number 00 to 59

t AM/PM First character of the '"AM' or 'PM' string; depends on system
regional settings

£ (o) AM/PM 'AM' or 'PM' string; depends on system regional settings

Y Year Year as a two digit number; if year has less than two digits
then one digit number will be displayed

vy Year Year as a two digit number; if year has less than two digits
then result will be padded with zero

Yyy Year Year as a three digit number; if year has less than three digits
then result will be padded with zeros

Yyyy Year Year as a four digit number; if year has less than four digits
then result will be padded with zeros

yyyy (y) Year Year as a five digit number; if year has less than five digits

then result will be padded with zeros

[other] Other characters are displayed without any change

Table 15 - Custom date formatting
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Examples:

Code Attribute value Result
{FIELD_NAME:d} 3rd of June 2008: 17:09:03.650, US English | '3'
{FIELD_NAME:dd} 3rd of June 2008: 17:09:03.650, US English | '03'
{FIELD_NAME:ddd} 3rd of June 2008: 17:09:03.650, US English | ‘Tue'
{FIELD_NAME :dddd} 3rd of June 2008: 17:09:03.650, US English | 'Tuesday'
{FIELD_NAME:M} 3rd of June 2008: 17:09:03.650, US English | '6'
{FIELD_NAME : MM} 3rd of June 2008: 17:09:03.650, US English | '06'
{FIELD_NAME : MMM} 3rd of June 2008: 17:09:03.650, US English | ‘Jun’
{FIELD_NAME : MMMM} 3rd of June 2008: 17:09:03.650, US English | "June’
{FIELD_NAME:y} 3rd of June 2008: 17:09:03.650, US English | '08'
{FIELD_NAME:yy} 3rd of June 2008: 17:09:03.650, US English | '08'
{FIELD_NAME:yyy} 3rd of June 2008: 17:09:03.650, US English | '008'
{FIELD_NAME:yyyy} 3rd of June 2008: 17:09:03.650, US English | '2008'
{FIELD_NAME:yyyyy} 3rd of June 2008: 17:09:03.650, US English | '02008'
{FIELD_NAME:h} 3rd of June 2008: 17:09:03.650, US English | '5'
{FIELD_NAME:hh} 3rd of June 2008: 17:09:03.650, US English | '05'
{FIELD_NAME:H} 3rd of June 2008: 17:09:03.650, US English | 17"
{FIELD_NAME:HH} 3rd of June 2008: 17:09:03.650, US English | 17"
{FIELD_NAME:t} 3rd of June 2008: 17:09:03.650, US English | 'P'
{FIELD_NAME:tt} 3rd of June 2008: 17:09:03.650, US English | 'PM"
{FIELD_NAME:m} 3rd of June 2008: 17:09:03.650, US English | '9'
{FIELD_NAME :mm} 3rd of June 2008: 17:09:03.650, US English | '09'
{FIELD_NAME:s} 3rd of June 2008: 17:09:03.650, US English | '3'
{FIELD_NAME:ss} 3rd of June 2008: 17:09:03.650, US English | '03'
{FIELD_NAME: £} 3rd of June 2008: 17:09:03.650, US English | '6'
{FIELD_NAME:ffff} 3rd of June 2008: 17:09:03.650, US English | '6500'
{FIELD_NAME:FFFF} 3rd of June 2008: 17:09:03.650, US English | '65'
{FIELD_NAME:yyyy/MM/dd | 3rd of June 2008: 17:09:03.650, US English | '2008/06/03
HH/mn/ss . ££££}) 17:09:03.6500'

Table 16 - Date formatting examples
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A.1.7 Formatting of STRING type attributes

Note: i is a placeholder for an integer number.

Format Name Description
character
s normal text | Text displayed without any changes.
S uppercase | Text displayed in uppercase.
S lowercase | Text displayed in lowercase.
i [at the first i>0 defines from which character (counting from the beginning
beginning] character | of the string) should be the string displayed; if i<0 then the
characters are counted from the end of the string.
i [at the last i>0 defines up to which character (counting from the beginning
end] character of the string) should be the string displayed; if i<0 then the
characters are counted from the end of the string.
H force force HTML interpretation of <> symbols
HTML
Table 17 - Custom string formatting
Examples:
Code Attribute value Result string Note
{FIELD_NAME:%} 'Abcdefghij’ 'Abcdefghij’
{FIELD_NAME:S} 'Abcdefghij' 'ABCDEFGHIJ'
{FIELD_NAME:s} '‘Abcdefghij’ ‘abcdefghij'
{FIELD_NAME:1$-1} 'Abcdefghij' 'Abcdefghij'
{FIELD_NAME:1S3} 'Abcdefghij' 'ABC'
{FIELD_NAME:1s3} 'Abcdefghij' 'abc’
{FIELD_NAME:1$-3} 'Abcdefghij' 'Abcdefgh’
{FIELD_NAME:-3%-1} 'Abcdefghij’ "hij’
{FIELD_NAME:4%$-4} 'Abcdefghij’ 'defg’
{FIELD_NAME:8%-8} 'Abcdefghij' " empty string
{FIELD_NAME:H} 'A<b>c' 'A&It;b; &gt;c'
{FIELD_NAME:H$} 'A<b>c' 'A&lt;b; &gt;c'
{FIELD_NAME:HS} 'A<b>c' 'A&It;B;&gt;C'
{FIELD_NAME:Hs} 'A<b>c' ‘a&lt;b;&gt;c'
{FIELD_NAME:H1s3} 'A<b>c' 'a&It;b’

Table 18 - String formatting examples
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A.2 Using symbology files

The Mapper supports symbology (SYM) files, which use a series of command instructions to
create custom line styles. When drawing the layer using a symbology file, the Mapper will
follow the rendering instructions to draw custom lines. The “mini-language” used to code the
instructions is set out in Table 19.

A.2.1 Transparent roads example

There are times when you wish to see the concentration contours but when the source
is displayed the contours are obscured. This can be the case for Road sources where the
highest concentrations are along the road. Hiding the road layer (unticking it in the
layer panel) is a possibility, but then you lose the visual information about the road
layout. On solution would be to display road sources with the contour plot showing
through — i.e. delineated by their borders alone so that the main body of the polyline
would be transparent.

The following example demonstrates how a symbology file can be applied to the Road
sources layer in order to produce the transparency effect described above.

Sstep 1 Double click on the layer of interest in the layer panel to bring up the layer
properties window — in this case bring up the properties for the Road
sources layer as shown in Figure 90.

Vector: Road sources (8) *
+ - X v a Visible
General Line
Sections
5 Section 1 Style Color Pattern
Renderer | j |. 0000FF j | j
Marker
»
Area Wi
Label |Widﬁ1‘1m ﬂ |E-n: J |E- deg J
Chart
3D Smart size
# Section 2 opt -
Qutline
Style Color Pattern
| | (W ] [ s -]
Width
1 twips -
¥ Indude in legend
& B
Wizard ... 0K | Cancel | Apply

Figure 90 - Layer properties window

Step 2 Choose Line from the left panel, and in the Line section, use the drop-down
menu under Style to choose the Symbol... button in order to bring up the
Symbol dialog, see Figure 91.
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Symbaol ot

Library ...
File ...

Font ...

i

MNaone

Cancel

Figure 91 - Symbol dialog

Step 3  Click the File button in the Symbol dialog and browse for the example .sym
file supplied with the installation, Figure 92.

Open x
Look in: | Data j & = Bl
% MName - Date modified Type
) Example3 2700772022 13:04 File fu
Guick access )
Exampled 270772022 13:04 File ft
vl Exampled 27/07/2022 13:04 File fi
Desktop Examplel0 27/07/2022 13:04 File ft
- | | Polyline border and dotted centeline.sym 06/01/2020 00:00 SYM
(o |
Libraries
This PC
Network
£ >
File name: |Pohf|ine border and dotted centeline.sym j Open |
Files of type: |,'-‘d| Supported Files j Cancel

Figure 92 - Selecting a symbology file

Step 4 Click OK to return to the Layer properties window (Figure 93) and either

click Apply or OK to apply the chosen symbology to the Road sources layer,
Figure 94.
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+ —
General
Sections
B Section 1

Renderer
Marker

X Ow A

Area
Label
Chart
3D

B Section 2

=l

Wizard ... |

Vector: Road sources ()

x
Visible
Line
Style Color Patter
| —— | [ -] | E
Width Symbaol Gap Symbaol Rotate
I\'n‘idh‘im j IDpt j IDdeg j
Smart size
Opt -
Qutline
Style Color Patte
| RN B -
Iltwips vl
v Indude in legend
CK I Cancel | Apply |

Figure 93 - Layer properties window with symbology selected

9 Mapper

Project  Edit View Layer Tools Settings Help

LZIPF TR CRRAQIOE +|Qa?|~v-EabmS0C EBE (9D

Layers Grouping an

B [+ Paint sources (1]
L]

B[+ Line sources (0]

B ¥ Area sources [0]

B [« Yolume sources (0]
B [v Grid source cells (1)
B [v Output orid extent

B ¥ Output grid points [961]

*
Canyon 13
ﬁﬁ/ﬁ-\i 5 \Canyun 12.8
=
ADMSUiban | View | B
Map: DSGB3E British National Grid (epsg: 27700] | *: 544306.44 Y- 25303248 | Editing: none Scale: 1:8500

A

Figure 94 - Roads layer with symbology applied.

Step 5 Load a contour layer to see the effects of the new rendering, Figure 95 and

Figure 96.
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K Mapper - O X

Project Edit View Layer Tools Settings Help

“9FFIBr G Raqdde s Qag(a-cund o EL (wd-

Layers Grauping a0

B [+ Point sources (1] ~
L]
B ¥ Line sources (0]

B [+ Road sources (8] L

- o

B ¥ Area sources (0]

ol

B [« Yolume sources (0]
A
B [v Grid source cells (0]

B [ Output grid extent

B [ Output grid points [981)

C o B
c et R R R R R

b b dedodhade & 4 & 4 B

4 & TR 1
4+ + RN -

4
R e e
T o &

ADMS-Urban I Wie I 200m

Map: O5GB36 British National Grid (epeg:27700) | *: 54454699 : 259221.72 |Editing none |Scale: 1:8.540

A

Figure 95 - Roads layer with symbology applied over a contour layer.

B Mapper - O X

Project  Edit View Layer Jools 3Settings Help

%9FTR BT ERAG B e+ Qad| v -EuMARNSOC | BE (WD

Layers Grouping inl

B [+ Paint sources [1] s
L]

B [« Line sources (0]

B [+ FRoad sources (8]

B [ Area sources [0]

B [« Yolume sources (0]
A

B [ Grid source cells (0]

B ¥ Output grid extent

B ¥ Output grid points [961]

ADMS Uiban | View | b 100m

Map: DSGB3E British National Grid (epsg: 27700] | *: B44355.36 - 258776.41 | Editing: none |Scale' 1:4,370

Figure 96 - Close up of Roads layer with symbology applied over a contour layer.

A.2.2 Making symbology files

The following list summarises the key elements of using symbology files

e All parameters (except GOTO) are relative and move the “drawing position”
cursor along the shape.
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e The X coordinate moves cursor along the shape. The Y coordinate moves
cursor perpendicularly.

e Drawing can contain as many commands as desired.
e Using GOTO(0) enables drawing over an already drawn line.
e FOR..END loop cannot be embedded into another loop.

e The more complicated the symbol, the slower the drawing speed.
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Commands
Full Short | Description Sample
i Comment out whole line ;A comment
GOTO (x) G Move drawing position along the shape to an | 970 (10%)
arbitrary position. G(10%)
MOVE (dx, dy) M Move drawing along line by a delta. MOVE (10, -10)
M(+10-10)
DRAW(x1,yl,x2,y |D Draw a vector segment. DRAW (5,5 5 -95)
2, ..,X0,yn) D (+5+5+5-5)
OUTLINE (x1,y1,x | O Draw a line symbol with the rotation point at | ©VTLINE (5,5 -
21Y2, . X0, y0) the place of the current “drawing position”. éO’_So ()j , =10 10,0
Whole symbol will be rotated with the same 0 (+5+5-10+0+0-
parameters. _ _ 10+10+0+0-10)
First set of coordinates means the starting
point of the shape.
FILL(xl,yl,x2,y |1 Draw a filled symbol with the rotation point | FLLL (5,5 ~10,0
27« s %0, y0) at the place of the current “drawing position”. 2(’))_1 0 10,00,-
Whole symbol will be rotated with the same T (+5+5-10+0+0-
parameters. _ _ 10+10+0+0-10)
First set of coordinates means the starting
point of the shape.
FOR (x) d Start of the loop. Parameters for the distance | FOR (50%)
the loop will be repeated. Default is 100%. A F(50%)
negative value means calculation starting
from the end of the line. For example, FOR(-
45%) means repeat until 45% of the distance
of the entire line length, starting from the end
of the line.
END () E End of the loop. ET? 0
WIDTH (x) W Change line width. WIDTH (10W)
W (10W)
COLOR(r,g,b) C Change drawing color. COLOR (255,0,0)
C(255,0,0)
COLOR (mode) C Change drawing color to: COLOR (1)
C(1)

0 - line/area color
1 - outline color

Table 19 - Symbology commands summary
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Values option

Option Description Sample
None Default — pixels GOTO (10)
X Device independent pixels - 1 pixel in 96dpi. Multiplied by 10 so 10X | GOTO (10X)
means one "pixel"
Twips (1/1440 of inch) GOTO (7007T)
W Line width (as set for Line.Width) expressed multiplied by 10. So 15T | GOTO (15T)
means 1.5 line widths.
S Line with scaled device independent pixels (similar to "X"). Scales means | GOTO (10S)
that wider lines will result no proportional scaling: 10X for thin lines
means really same as 10X but for wider line it will be represented by
smaller value for better visual effect
Table 20 - Symbology measuring settings
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A.3 Supported file types

This section details the file types that are supported by the Mapper.

A.3.1 Recognised file types

The Mapper supports loading the following recognised file types and formats natively.
This allows them to be displayed in the map view as new non-editable layers. The list
is not comprehensive, but gives the most commonly supported file types.

Format

ArcExplorer Project File

Arcinfo Ascii Grid

Arcinfo Binary Grid

Arcinfo Export Format

Arcinfo Float Grid

ArcView 3.xx Project File

ArcView Shape Files

AutoCAD DWG

AutoCAD DXF

Binary Terrian Grid

CADRG Compressed ARC Digitized Raster Graphics
Census 2000 TIGER/Line

Comma Separated Values point layer (CSV)
Digital Elevation Model (ASCII GRID or SPOT)
Digital Line Graphs (DLG)

Digital Terrain Elevation Data

Enhanced Compressed Wavelet

ERDAS IMAGINE Image File Format
ESRI File Geodatabase API for vectors
FME Feature Store

GDAL Wrapper for raster formats
Geographic Data Files

Geographic Markup Language

GeoJSON

Global Self-consistent Hierarchical High-res Shorelines GSHHS
Golden Software Surfer Grid

Google Earth Keyhole Markup Language
GPS Exchange Format

Graphic Interchange Format

IFC

IHO S-57 ENC

JPEG 2000 via ECW

JPEG 2000 via MRSID

JPEG File Interchange Format

LandXML

File extension
*.aep

*.asc

*.adf

*.e00

* flt

*.apr

*.shp

*.dwg

*,dxf

* bt

*.toc

*rtl

*.csv and others
*.dem
*.opt;*.dlg
*,dt0;*.dt1;*.dt2
*.ecw

*.img

* ttkls; *.ttklayer
* ffs

(multiple)

*.gdf
*.gml;*.xml
*.json;*.geojson
*rim;*.b

*.grd

* kml;*.kmz
*.gpX

*.gif

*.ifc and others
*,000

*.Jp2

*.Jp2
*.jpg;*.jpeg
*xml
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A.3.2

LiDAR LAS (ASPRS)
Lizardtech MrSID

Mapbox Vector Tile Format
Maplnfo Interchange Format
MapInfo Native Format
MapInfo WorkFile

MapInfoX Project File
MicroStation Native Format
OGR Wrapper for vector formats
Open Asset Import Library
OpenStreetMap Format
Pictometry Oblique Images

PLY Polygon File Format
Portable Network Graphic
Protocol Layer Connector

QGIS Project File

SAGA GIS Binary Grid

SDTS Raster Profile and Extensions
SDTS Topological Vector Profile
SPOT Binary In-line Format
SQL Layer Connector

SRTM HGT Grid

Standard Tessallation Language
Tag Image File Format
TatukGIS PixelStore

TatukGIS Project File

Vector Product Format (VPF)
WexBIM

Window Bitmap

XYZ Point Cloud data

Overriding recognised file types

* las;*.laz

*.sid

*.mvt;*.pbf

* mif

*.tab

*.wor

*.gst

*.dgn

(multiple)
(multiple)
*.0sm;*.pbf
*.psi

*.ply

*.png

* ttkwp; *.ttklayer
*.q0s;*.q9z

* sdat

*.ddf

*.ddf

* bil;*.dem

* ttkls;*.ttklayer
*.hgt

* stl;*.stla

* tif; > tiff

* ttkps;*.ttklayer
* ttkproject;*.ttkgp
*.dht; *.Inht

* . wexbim

*.bmp

*.Xyz; *.asc

Files containing numerical data may share extensions with one of the recognised file
types. The showForm Setting under the [ExtendedFileTypes] Section in the ADMS
model interface *.ini file specifies a list of file extensions that should be handled as a
general numerical data file. This allows displaying of the file as in Section 3.4. The
value for this setting is a semicolon-delimited string of file extensions.

Example
ShowForm=*.csv; *.ext

Mapper User Guide

Page 130



APPENDIX A — Advanced topics

A.3.3 Adding bespoke text file types

The knownTypes Setting under the [ExtendedFileTypes] Section in the ADMS
model interface *.ini file expands the Mapper’s file handling for known file types.
This setting defines a list of custom behaviours for specific file extensions by pointing
to a layer configuration (*.ttkstyle) file stored in the Config directories in the ADMS
model install. The value for this setting is a semicolon-delimited string of known file
types. Each file type section includes up to three additional parameters: the
configuration file, the header alias and the data start line, separated by a pipe (“|”).

The general form of a file type section is as follows, where []1 denote optional entries
extension| [style] | [header] | [start];

A.3.3.1 Extension
The extension is required in order to identify the file type. It may be written

*.ext
.ext

ext

A.3.3.2 Style

The style file reference is optional, but the file will need to exist for the layer to be
customised. If it is omitted, the Mapper assumes that the file name matches the
extension, e.g. ext.ttkstyle for *.ext files.

There are predefined configuration files using an enumeration number for the standard
ADMS layers. You can reference these if you wish your added layers to look similar
to one of these.

If a section omits a parameter, you must include the appropriate pipes if you wish to
define a later parameter, e.g.

*.ext||index,X,Y,Z|2;

A.3.3.3 Header alias

The header alias is an optional parameter. If the file type always contains a header,
you do not need to set it here. There is an assumption that the first non-blank line will
be the header if you don’t define the header alias.

Even if the file type does always contain a header, you can use the alias to

e  Skip columns using a dash or space or nothing
Xy Yr—r—r2
14 XI YI 14 14 Z

14 XI YI rs Z
e Redefine columns, e.g. set a column to Z and it will be used as elevation
Xy YrZy Ty~

e Define polylines using X1, Y1 etc., as described in 5.5.3
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A.3.3.4 Start line

The start line is optional, although there are times when it is useful. For example, if the
file type always has a header but you have defined a header alias, set the start line to
skip over the file header. With a header alias defined, the first non-blank line from the
start line will be considered as data.

Example
KnownTypes=*.exl |bespoke.ttkstyle|X,Y,Z;*.ex2;*.ex3||X,Y,Vall|2
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